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1 About the InteGrade Pro Software

The InteGrade® Pro teacher gradebook helps teachers track student performance over the duration of 
a course. It can record a virtually unlimited number of tasks and students per gradebook. You can 
organize tasks and put them into categories such as homework, quiz, or lab exercises. You can reward 
good performance with bonus scores and correct poor performance by graphically showing a student 
where they stand or adjusting scores. 

The platform compatibility of InteGrade® Pro gradebook software means you can move your files from 
a Microsoft® Windows® to a Macintosh® computer. Switching platforms requires no conversion and 
preserves nearly all features.

At the end of a term, the system can transmit final grades back to the main office system to print 
report cards.

New Features in the InteGrade Pro 9.2 Software
InteGrade Pro 9.2 is a fairly major release offering new features and several important defect 
corrections.

Grade Tables has been modified to make this easier to understand.

InteGrade Pro can now include fewer spreadsheets in a multiclass report, based on 
spreadsheets having an associated date range. You'll need to use Setup->Spreadsheets to 
assign date ranges to your numeric and skill spreadsheets before you use this feature.

InteGrade Pro can now optionally BCC (“blind carbon copy”) emailed reports to your email 
address.

Instead of prefixing a ~ to an inactive student’s name, the student's information will be struck 
out.

In the main viewer area, the inactive student’s information will appear in a different color, and 
his or her name will appear in (parenthesis).

You can now turn inactive student display on and off from the main viewer.

You can now change where inactive students sort relative to active students in Setup->Display 
on the Spreadsheet tab.

Personal notes, which do not appear on reports and will not be exported.

The Empty Scores option for missing tasks no longer includes empty scores on bonus tasks. A 
blank score indicates something different for a bonus task (“no bonus”) than a regular task 
(“not entered yet”). The other options still affect bonus tasks.
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About the InteGrade Pro Software
Viewing a bonus task as a letter grade will now produce a letter grade of n/a, rather than 
displaying a letter grade from the table. This fix affects areas missed by the fix in 9.1.2 (which 
only addressed certain reports and certain types of bonus task).

Support for scanning scores for students with very long student numbers.

InteGrade Pro System Requirements
The InteGrade Pro version 9.2 software can be installed regardless of whether you have a previous 
version of InteGrade Pro installed on your system.

System requirements vary depending on the type of installation you are performing. Be sure to read 
the InteGrade Pro Readme help file for additional requirement information. The Readme help file 
displays at the end of the installation procedure.

InteGrade Pro Requirements
These requirements are for users who are installing the InteGrade Pro software on a stand-alone 
computer as well as for those who connect to InteGrade Pro Server from a computer at school or at 
home.

Additional requirements for the InteGrade Pro Web software are listed in a separate section below.

Windows Operating System  Windows® 98 SE, 2000, or Windows XP

A computer that meets the requirements for the version of Windows you are running

At least 20 MB available hard disk space (48 MB with scanning tools)

At least 32 MB RAM

Macintosh Operating System  Mac OS 8.6, Mac OS 9.2.2, or Mac OS X with Classic 9.2.2. Note that 
InteGrade Pro only runs in Classic mode on Mac OS X. For Mac OS 8.6 and Mac OS 9.2.2 you 
also need the Mac OS Runtime for Java (MRJ) 2.2.5 or higher from http://developer.apple.com/
java/download.html. 

At least 20 MB available hard disk space.

At least 32 MB RAM.
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About the InteGrade Pro Software
InteGrade Pro Web Requirements
Computers connecting to the InteGrade Pro Server software using the InteGrade Pro Web software 
must meet the following conditions:

Pearson School Systems supports the following Web browsers for use with the InteGrade Pro 
Web software:

Internet Explorer 5.1.7 for Macintosh OS 8 or OS 9 systems.

Internet Explorer 5.2.3 or later for Macintosh OS X systems.

Internet Explorer 5.5 SP2 for Windows 98 SE systems.

Internet Explorer 6.0 with SP1 for Windows 2000 and XP systems.

Netscape® Navigator 7.02 for Mac OS 9

Netscape Navigator 7.1 for Mac OS X systems.

Safari 1.2 for Mac OS X systems.

The InteGrade Pro Web software may not fully support earlier versions of these Web browsers. 
If remote computers use unsupported versions, please ensure that their JavaScript settings 
are disabled and be aware that the formatting of the Web pages might not be optimal.

Your computer must have an Internet connection speed of at least 28.8 kbps.

The InteGrade Pro Software and Administration 
Systems
The InteGrade Pro teacher gradebook can exchange data with the following Pearson School Systems 
administration systems:

SASIxp™ student information system

SASI™ III student administrative software

CIMS® financial software

The School System™ software (TSS)

The Elementary School System™ software (TESS)

OSIRIS® student information management software

One of the general requirements for this exchange is to export the necessary data from the 
administration systems to populate InteGrade Pro teacher gradebooks with class rosters, attendance 
calendars, course IDs, and so on. Another is to import grades and/or attendance information from 
InteGrade Pro gradebooks into the administration systems. 
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About the InteGrade Pro Software
The data exchange feature of the InteGrade Pro software lets you transfer data between the 
administration system and InteGrade Pro gradebook software. For example, you can transfer up-to-
date information between databases without having to manually enter data. You can also transfer 
different types of data such as the following:

Teacher

School information

Student, with demographic information

Class rosters

Grades

Data validation rules

Grade tables

Some Words You Should Know

Scores and Grades
Scores are the input values – the marks that students receive on individual tasks such as tests or 
homework assignments.

Grades are the output values – the result of calculations that use scores. Calculations are performed 
according to the task and task type weighting schemes that you create.

Class
A class is a single course taught in a single period as defined by your office administration computer 
system. It consists of spreadsheets, students, tasks, and a task type set.

Tasks, Types, and Sets
Tasks are work items that you assign to students like a quiz on King Lear or a set of math problems. 

Task types are categories such as Quiz, Homework, or Lab exercises. Task type sets group task types 
together. 
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About the InteGrade Pro Software
For example, suppose you teach biology and english. Your biology class has a lab, but your english 
class does not. In that case you would use four task types: Homework, Quiz, Lab, and Exam. You 
would group them into two task type sets: Sciences and Humanities. Sciences includes the Lab task 
type, while Humanities does not.

You can define as many task type sets as you like, then assign one set to each class.

Comments and Notes
Comments are the short phrases used on report cards to describe the progress of a student. The End 
Term spreadsheet can submit comments back to the office system, along with the final grades. The 
number of comments per student to export depends on the office system.

Notes are anecdotal text that you enter for classes, tasks, students, and individual scores. You can 
specify a paragraph is a personal note (which is not exported or printed on reports) by starting $$ at 
the beginning of a paragraph. This is intended for convenience only; if you would not write something 
down on paper about a student, then you probably should not put it in your gradebook either.

Spreadsheet
A spreadsheet is a collection of tasks and scores for a single class. It records student scores in a grid 
structure. Each class can have more than one spreadsheet, for example, for different reporting 
periods. 

There are four types of spreadsheets used in the InteGrade Pro software.

Table 1-1. Tasks, types and sets

Task Type Set

Othello Quiz Humanities

Alice in Wonderland Homework Humanities

English 201 Midterm Exam Humanities

Cell Division Quiz Sciences

Individual Study Homework Sciences

Plant Propagation Lab Sciences

Biology Exam Exam Sciences
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About the InteGrade Pro Software
Numeric  This is the traditional gradebook where a teacher enters scores and calculates grades. The 
student names are on the left side of the screen, with scores in the middle and the calculated grades 
on the right side

Figure 1-1. Numeric spreadsheet (traditional gradebook)
.

Scores can be numeric or text labels represented by special scores.

Each numeric spreadsheet can have a different letter grade table. This enables you to use different 
grading rules for sets of tasks or for different terms.

When you create a numeric spreadsheet, you have two choices, either a Weighted or a Total Points 
type. 

The Weighted type spreadsheet uses task types to weight scores when calculating the final 
spreadsheet grade. Weighted type numeric spreadsheets display a Percent (%) column and a Letter 
Grade column. You can customize these columns to display one of 10 other statistical transformations 
of the final spreadsheet grade.

The Total Points spreadsheet calculates the spreadsheet grades based on points received versus points 
possible. It does not use task types to weight scores when calculating the final spreadsheet grade. The 
Total Points numeric spreadsheet displays a Points Received column (showing the sum of all points 
scored by each student for all tasks on the spreadsheet) and a Letter Grade column. You can 
customize the last two columns to display a percentage or one of 14 other statistical transformations 
of the final spreadsheet grade.
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Skill  The skill spreadsheet looks like a numeric spreadsheet, except that it does not calculate grades. 
It shows whether students have acquired certain skills.

Figure 1-2. Skill spreadsheet

Use skill spreadsheets to track student proficiency in specific content areas. Scores are not associated 
with a numeric value, and spreadsheet grades are not calculated.

Attendance  An attendance spreadsheet records student attendance for the class. Each spreadsheet 
records attendance day by day, once per day. You can create multiple attendance spreadsheets, if 
necessary, within a class.

Figure 1-3. Attendance spreadsheet
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End Term  The InteGrade Pro software creates an End Term spreadsheet only when you import your 
class roster file from an administrative system. It stores the data that you send to the main office at 
the end of a reporting period.

Figure 1-4. End Term spreadsheet

The End Term spreadsheet appears as a simplified version of the numeric spreadsheet. The student 
demographic column displays the same information. Columns record comments, attendance, and final 
grades replace task score columns. 

The End Term spreadsheet reflects any sorting or reordering in the numeric spreadsheet and vice 
versa. The appearance of your End Term spreadsheet can vary, depending on the administration 
system and on the mark types your system administrator has set up for you to complete.

The Comments column contains the numbers for the comments printed on the report cards. Most 
school administrative systems use preset comments identified by numbers. You can use a 
comments.txt file to assist you with entering the comments. 

The Attendance column contains the number of absences for each student for the reporting period. 
Use the Replace Tasks command to total the absences, accessed by clicking on a column title. You can 
also use the Copy Tasks command from the Tasks menu.

The Final grades column contains the final grades to be printed on the report cards. Each numbered 
column represents a specific mark type recorded for the reporting period. You should have received 
instructions regarding the information to enter for each column. It is very important to enter the 
grades in the correct column.

Gradebook
A gradebook keeps track of all the students and classes you teach. The InteGrade Pro software uses 
one gradebook per teacher, regardless of the number of students or classes taught. If you teach at 
more than one school, you must have a separate gradebook for each school. A gradebook contains 
students, classes, special scores, and letter grade tables.

You can have only one gradebook open at a time.
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The Toolbar Icons
Figure 1-5 shows the function of each button on the Toolbar.

Figure 1-5. Toolbar icons

Class Viewer
A class viewer displays one spreadsheet for one class. When you open a gradebook file, a viewer opens 
automatically.

NOTE: A class viewer provides a way to switch between classes and between spreadsheets. You can 
open more than one viewer. For example, each viewer could display a different class. You 
may open up to 12 class viewers at once.

Open 
Gradebook Print 

Save 
Gradebo Copy

New 

Paste

Find
Again

Cut
Edit 
Spreadsheets

Edit 
Task

Task Comparison 
Student Performance 

Task Correlation Find

Edit 

Next Spelling
Error

Help
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Figure 1-6. Class viewer

If you prefer a clean desktop, open one viewer and use the drop-down lists to switch between classes 
and between spreadsheets within a class. If you prefer to organize data over several windows you can 
open multiple viewers and use the organizing commands in the View and Window menus to manage 
the multiple viewers.

The Show drop-down list lets you turn on or off the Tasks, Students, and Notes areas. For example, 
when you are creating your task list at the beginning of the year, you might only want to see tasks. If 
you are entering scores, you might only want to see the students. The drop-down list changes 
depending on the spreadsheet being viewed.

The View drop-down list – for a Numeric spreadsheet only – lets you toggle between task and task 
type view. Task view shows the individual tasks. Type view rolls everything into the respective task 
types (for example, homework or quizzes). This view is ideal for you to quickly see how your class is 
faring on various tasks. 

You can customize the column headings in the task and student areas. You can turn auxiliary 
columns on or off and customize their contents. For example, you may choose to see percentage or 
letter grade, or one of a dozen score transformations. See Customizing Spreadsheet Columns.

1. Select a class from the drop-down list.

2. Select any spreadsheet associated with that class.

3. Select what you want to see in this spreadsheet.

4. Select Task or Type.

Auxiliary columns that you can 
choose to display or not, as well as 
choose what is displayed in them.
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About the InteGrade Pro Software
To open viewers:
1. From the View menu, select Open Class Viewer. 

2. Select the class you want to view. 

3. Click Open. This second viewer might cover your first. Use the Window menu to switch from one 
viewer to another, or to arrange the viewers on screen. You may also resize and move each viewer 
so that both are visible at once.

To close viewers:
1. To close a class viewer, select the viewer you want to close so that it is the active window.

2. From the View menu, select Close Class Viewer. You can also click the Close box in the corner 
of the window.

NOTE: Closing a viewer does not affect data already entered. Closing the last viewer closes the 
gradebook.

Context Menus
Context menus are the shortcut menus that display when you right-click (Windows) or Ctrl-click 
Macintosh) in certain areas of the viewer.

For example, if you display the context menu in the task area of a spreadsheet, you are presented 
with two sort options, as well as shortcuts to the New Task and the Edit Task menu items.

Context menus are used throughout the InteGrade Pro software. Another example is in the seating 
chart. If you display the context menu, by right clicking on a desk, you are presented with the options 
to Fill Chart or Replace Task. You will also see a list of attendance codes.

Figure 1-7. Context menus
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About the InteGrade Pro Software
Overview of a School Year
At the start of the year, you create a new gradebook, then import a class roster file from your 
administration database. Although you can create a gradebook manually, you must import a data file 
if you want to export data back to the office.

Next, you customize the gradebook to suit your teaching methodology by setting up the task types and 
scoring schemes. You can also import tasks. This may already be set up if you electronically imported 
your class data.

For the remainder of the year, you use the InteGrade Pro software to record student scores on tasks, 
record student attendance, and print reports. 

At the end of each reporting period, you can export data to the school’s administration computer for 
grade reporting. 

At the end of the school year, you back up and archive your data.

The following diagram is an overview of how you use the InteGrade Pro software at each stage of the 
reporting period.

Figure 1-8. School year overview

2. Add tasks and scores
and notes throughout the
reporting period, and take
attendance.

School
Administration

System
InteGrade Pro

1. Import class roster file
from school administration
system into InteGrade
Pro.

3. Export your EndTerm
spreadsheet to the school
administration system at
the end of the reporting
period.

Abbasi, Elisa  7  9.5  26  11 11.5
Bregder, Audrey  6  10.5  27  11.5  9
Calder, Cara  8.5  13  31  14.5  11
Castro, Michael  6.5  Sick  26  10
Cortez, Miguel  7  9.5  32  INC  11.5

Abbasi, Elisa  7  9.5  26  11 11.5
Bregder, Audrey  6  10.5  27  11.5  9
Calder, Cara  8.5  13  31  14.5  11
Castro, Michael  6.5  Sick  26  10
Cortez, Miguel  7  9.5  32  INC  11.5

School
Administration

System
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About the InteGrade Pro Software
File Naming Conventions

File Name Prefixes
CL  Files created by the administration system are named CLxxxxxx.GRD. The CL prefix designates 
the file as a Class Roster file and the xxxxxx's represent your teacher code. These files contain 
information on classes and students, and define the End Term spreadsheet.

MK  Files created by the InteGrade Pro software are named MKxxxxxx.GRD. The MK prefix 
designates the file as a Marks data file and the xxxxxx's represent your teacher code. These files 
contain information on grades and attendance.

AB  Files created by ABACUSxp are named ABxxxxxx.GRD. The AB prefix designates the file as an 
ABACUSxp file and the xxxxxx's represent your teacher code. These files contain task information 
and can be imported into the InteGrade Pro software to record mastery values on the skill 
spreadsheet.

AT  Test files created by ABACUSxp are named ATxxxxxx.GRD. The AT prefix designates the file as 
an ABACUSxp file and the xxxxxx's represent your teacher code. These files contain test information 
and can be imported into the InteGrade Pro software to record test values on the skill spreadsheet.

File Name Suffixes
GBF  Gradebook file; for example sample.gbf

GRD  Class roster files, used in import and export (TSS and Osiris use .GC); for example cljoanfr.grd

BAK  Backup file that preserves a previous version of your gradebook

A BAK file is a back-up file that preserves the second-to-last version of your gradebook, usually in the 
InteGrade Pro software program file folder of your hard disk. The BAK file is titled “name of your 
gradebook file”.BAK. Until you save a gradebook a second time with a new password, the .BAK file 
version of the saved gradebook does not incorporate new or changed passwords. 

See InteGrade® Pro Administrator’s Guide Version 9.2 for the complete list of files used in importing 
and exporting to other administration systems.

Working On a Macintosh System
The Macintosh operating system is able to handle both Macintosh and Windows files, but the 
Windows operating system can handle only Windows files.

As a result, if you are using the system in a mixed environment and plan to open your gradebooks on 
both Macintosh and Windows systems, you must name your files according to Windows 
standards.

If you always use Windows standards for naming your files – even while working on a Macintosh – 
the Windows operating system can always handle files from your Macintosh and you will not have to 
take any additional steps.
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About the InteGrade Pro Software
Where to Find More Information
If you have a question about the InteGrade Pro software or need more information, use the online 
help system or this manual. If you need additional assistance, you can contact Pearson School 
Systems.

Using the Online Help System
The help system contains the information found in this guide in an easy-to-access format. There are 
two ways to use the help system:

Choose Contents from the Help menu (Windows) or choose InteGrade Pro Help from the Help 
menu (Mac). This opens the contents topic and lets you browse the help system or search for 
specific topics.

Click the Help button on a screen or press <F1> (or the <Help> key on the Mac). This displays 
a help topic about that screen with links to topics describing all the procedures that can be 
performed from that screen. 

Technical Support Services
Pearson School Systems offers the following services to users with active maintenance agreements:

World Wide Web: Users with active maintenance agreements can get technical support from 
the Pearson School Systems Web site. Fill out the form on Customer Link 
(customerlink.pearson.com) and a support person will send an e-mail response to you. You 
must be using a browser that displays forms to use this service.

Training: For information about the training services available from Pearson School Systems, 
or to schedule training, call (800) 736-4357.

Customer Service: For information about other products available from Pearson School 
Systems call (800) 736-4357.

When Requesting Technical Support  Be sure you include the following information when requesting 
technical support:

Your site number.

The version number and platform of the InteGrade Pro software. For example, InteGrade Pro 
9.2 for Windows or InteGrade Pro 9.2 for Macintosh.

Your computer make and model. For example, Dell® Dimension XPS 166 or Apple Power 
Macintosh® 6100/60.

The computer operating system and version number. For example, Windows 2000 or Mac OS® 
X 10.2.8.

If the product is running on a local area network, the network operating system and version 
number.
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About the InteGrade Pro Software
Receiving Support from Other Vendors  If you purchased the InteGrade Pro software from a company 
other than Pearson School Systems, you should contact that company for technical support. You 
should have received information on technical support services available from that vendor at the time 
of purchase as well as upon receipt of the product.
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2 Installing the InteGrade Pro Software

The InteGrade Pro software is available for download on the Customer Link Web site. The following 
sections contain the installation and configuration procedures for the InteGrade Pro software. 

Introduction
You can install the InteGrade Pro software and either connect to InteGrade Pro Server (to access 
gradebooks on your school’s server) or work with it locally on your computer. You can also use 
InteGrade Pro Web to access gradebooks remotely. If you wish to use InteGrade Pro Web to access 
gradebooks from a remote computer, you do not need to install the InteGrade Pro software. You can 
use InteGrade Pro Web as long as you have an Internet connection and an appropriate browser level.

InteGrade Pro 9.2 software can be installed regardless of whether or not you have a previous version 
of InteGrade Pro installed on your system.

Authorization Settings
If you choose to install the InteGrade Pro software (rather than simply using the InteGrade Pro Web 
software), you will need to have authorization information available.

The authorization information includes the Licensee Name, the Site Number, and the Authorization 
Key. This information is available from your system administrator.

General Installation Information
The InteGrade Pro Software  You can use the InteGrade Pro software as a stand-alone product or on a 
remote computer that connects to the InteGrade Pro Server software. The functionality which allows 
the InteGrade Pro software to connect to the InteGrade Pro Server software can be turned on and off 
with a setting in the Preferences menu of InteGrade Pro.

The InteGrade Pro Web Software  The InteGrade Pro Web software does not require you to install any 
InteGrade Pro software on your system. Once the InteGrade Pro Server software is installed and 
configured at your school, a remote computer with an Internet connection can connect using the 
school’s Web server URL and a user ID and password, which are assigned by your system 
administrator.
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Installing the InteGrade Pro Software
Before You Begin
The computer on which you wish to install the InteGrade Pro software must be connected directly (via 
cables) to your school’s network.

Installing the InteGrade Pro Software
The following procedures show how to install the InteGrade Pro software on a stand-alone computer 
or on a computer that connects to the InteGrade Pro Server software. 

Downloading and Installing to a Windows PC
You must have WinZip or a similar archive program to extract the installation files after downloading 
them.

To download and install the InteGrade Pro software:
1. Sign in to the Customer Link Web site at customerlink.pearson.com.

2. Go to the InteGrade Pro Software Downloads Web page. (On the Customer Link Welcome page, 
select InteGrade Pro in the Product Support Center list, and then click the IGPro 9.2 link under 
Downloads.)

3. Click the IGPro_9.2_WIN.zip link and save the file to the root directory on your hard disk, 
usually C:\.

4. Unzip the IGPro_9.2_WIN.zip file to the root directory on your hard disk.

5. In the unzipped folder, open the \IGPro folder.

6. Double-click Setup.exe and follow the instructions in the Installation wizard.

7. When prompted, type your Licensee Name, Site Number, and Authorization Key, and then 
click Install. If you cannot find the authorization letter with this information, contact technical 
support or your InteGrade Pro representative. 

8. On the Finished screen, click Next to view the Release Notes. Pearson School Systems 
recommends that you read the information in this file carefully as it contains important last-
minute installation and configuration information.

9. On the Install Complete screen, click Done to quit the installer. A shortcut to InteGrade Pro is 
placed on your desktop.
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Installing the InteGrade Pro Software
Downloading and Installing to a Macintosh Computer

To download and install the InteGrade Pro software:
1. Sign in to the Customer Link Web site at customerlink.pearson.com.

2. Go to the InteGrade Pro Software Downloads Web page. (On the Customer Link Welcome page, 
select InteGrade Pro in the Product Support Center list, and then click the IGPro 9.2 link under 
Downloads.)

3. Click the IGPro_9.2_Mac.sit.hqx link. The file saves to your desktop.

4. Double-click the IGPro_9.2_Mac.sit.hqx file to unstuff it.

5. In the unstuffed folder, open the \IGPro folder.

6. Double-click Install InteGrade Pro and follow the instructions in the Installation wizard.

7. When prompted, type your Licensee Name, Site Number, and Authorization Key, and then 
click Install. If you cannot find the authorization letter with this information, contact technical 
support or your InteGrade Pro representative. 

8. On the Finished screen, click Next to view the Release Notes. Pearson School Systems 
recommends that you read the information in this file carefully as it contains important last-
minute installation and configuration information.

9. On the Install Complete screen, click Done to quit the installer.

Using the InteGrade Pro Web Software
The InteGrade Pro Web software installs when the InteGrade Pro Server software is installed.

A remote computer that will be using the InteGrade Pro Web software to access gradebooks on the 
school's server requires the following:

It must use an Internet browser that meets the minimum system requirements (chapter 1, 
“About the InteGrade Pro Software,” on page 1).

It must have a connection to the Internet (dial-up, cable, etc.)

The Internet browser should be set to JavaScript enabled (performance is optimal when 
JavaScript is enabled).

The browser must be set to accept cookies.

Once these conditions have been met, users should refer to this guide for information on logging in to 
the Web and working with gradebooks.
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3 Working with Gradebooks

After you have installed the InteGrade Pro software, you must complete some settings. Once you have 
completed these settings, learning how to open your gradebooks is the next step. The procedure for 
opening gradebooks is different depending on the configuration selections you make the first time you 
run the InteGrade Pro software.

Important InteGrade Pro Features
The information in this section does not apply if you are using the InteGrade Pro software as a stand-
alone product (storing gradebooks only locally on your computer). This section is only applicable to 
those users who connect to the InteGrade Pro Server software.

When you use the InteGrade Pro software in conjunction with the InteGrade Pro Server software, 
there are a number of important features of which you should be aware.

Messages
If you are working on a computer that connects to the InteGrade Pro Server software at your school, 
each time you open a gradebook the system connects to the InteGrade Pro Server software, updates 
the gradebook with any new information and downloads the gradebook to your computer. During this 
process, the Download Gradebook window displays new messages (bulletins) created by the 
InteGrade Pro system administrator.

To view messages (Windows and Macintosh Users):
1. Open the InteGrade Pro software.

2. On the InteGrade Pro banner screen, select Open a gradebook on a server and click OK.

3. On the Open gradebook screen, double-click the server to which you wish to connect. This is 
where your gradebooks are stored.

4. Enter your user ID and password for the server connection and click OK. When the connection is 
made, a list of available folders and gradebooks will be displayed.

5. Open a gradebook. The gradebook is opened and a screen displaying the download status and all 
new messages is displayed. Read the messages and click on any links within the messages.

6. Once the download is complete and you have finished reading the messages, click OK. The 
gradebook is opened and the last spreadsheet edited displays.
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Working with Gradebooks
Passwords
You can have two different types of passwords with the InteGrade Pro software.

Network Passwords  If you work on gradebook files stored remotely on the school’s server, you need a 
password for connecting to the InteGrade Pro Server software. This password is initially assigned by 
your system administrator. It protects your remotely-stored gradebooks.

Gradebook Passwords  The other type of password used with the InteGrade Pro software is a 
gradebook password. This password is for protecting gradebooks stored locally on your computer.

You can change both types of passwords using options on the Setup menu in the InteGrade Pro 
software. When you select the Password option off of the Setup menu, you see a series of Password 
wizard screens that walk you through adding, removing or changing your password. The screens in 
the wizard vary depending on the gradebook you are working on. If you are working on a locally-
stored gradebook, the Password wizard enables you to assign or remove a gradebook password. If you 
are working on a remotely-stored gradebook, the Password wizard enables you to change your 
network login password.

For detailed instructions on adding or removing a gradebook password, “Working Securely” on page 
59
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Working with Gradebooks
Starting the InteGrade Pro Software

Starting the InteGrade Pro Software for the First Time
The procedure for opening the InteGrade Pro software the first time is different from the procedure 
used for opening the InteGrade Pro software all subsequent times.

The first time you run the InteGrade Pro software you are given the option of indicating whether you 
will be using it as a stand-alone (only storing gradebooks locally) or whether you will be connecting to 
the InteGrade Pro Server software (storing gradebooks remotely).

Starting Without the InteGrade Pro Server Software  Use this procedure to open the InteGrade Pro 
software the first time only if you will not connect to the InteGrade Pro Server software. This 
procedure configures your system to run as a stand-alone or to run on the school's LAN without using 
the InteGrade Pro Server software.

To start without the InteGrade Pro Server software:
1. Open the InteGrade Pro software. You see the following screen:

Figure 3-1. Starting InteGrade Pro

2. Select No. This indicates that you are installing without connectivity to the InteGrade Pro Server 
software.

3. Click Continue. The InteGrade Pro banner screen is displayed.

4. Select Open a gradebook on your computer and click OK. The Open screen is displayed.

5. Click Cancel. This completes the requirements for the first-time startup of the InteGrade Pro 
software.
Copyright © 2005 Pearson School Systems InteGrade® Pro User’s Guide, rev. July 8, 2005

21



Working with Gradebooks
Starting with the InteGrade Pro Server Software  Use this procedure to open the InteGrade Pro 
software the first time only if you will be connecting to the InteGrade Pro Server software. This 
procedure configures your system to store gradebooks remotely on the school's server.

To start with the InteGrade Pro Server software:
1. On the computer desktop, double-click the InteGrade Pro software icon. You see the following 

screen:
Figure 3-2. Starting InteGrade Pro

2. Select Yes. This indicates that you are installing on a computer that will connect to the 
InteGrade Pro Server software at school.

3. Click Continue. The InteGrade Pro banner screen is displayed.

4. Select the Open a gradebook on a server option and click OK. The Open Gradebook screen 
appears.

To see a description of the parts of the Open Gradebook screen, click the Help button.

5. At this point teachers must add server connectivity so that the computer can connect to the 
InteGrade Pro Server software.

6. See the online Help and this guide for instructions on connecting to the remote server and 
opening and closing gradebooks.

Starting the InteGrade Pro Software (After the First Time)
If you are starting the InteGrade Pro software for the first time, refer to the procedures in the 
preceding sections. These procedures are for starting the InteGrade Pro software after the first time.

Starting Without the InteGrade Pro Server software  For all subsequent times that you open the 
InteGrade Pro software, do the following.

To start without the InteGrade Pro Server software:
1. Double-click the InteGrade Pro software icon.

2. On the InteGrade Pro banner screen, select Open a gradebook on your computer and click 
OK.

3. On the Open screen, select a gradebook file and click Open.
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Starting With the InteGrade Pro Server software  For all subsequent times that you open the InteGrade 
Pro software, do the following. 

To start with the InteGrade Pro Server software:
1. Be sure you are connected to the Internet.

2. Double-click the InteGrade Pro software icon. The InteGrade Pro banner screen is displayed.

3. On the InteGrade Pro banner screen, select Open a Gradebook on a Server and click OK. The 
Open Gradebook screen appears.

4. See the online Help or the guide for instructions on connecting to the server and opening and 
closing gradebooks.

Turning Connectivity to the InteGrade Pro Server Software On and Off
The functionality for connecting to the InteGrade Pro Server software can be turned on and off using 
the Preferences screen on the Edit menu in the InteGrade Pro software. This feature is useful if you 
originally installed the InteGrade Pro software without connectivity to the InteGrade Pro Server 
software and then you decide to connect to your school’s server.

To turn the InteGrade Pro Server software connectivity on or off:
1. Open the InteGrade Pro software.

2. Go to the Edit menu and select Preferences.

3. Select or clear the Use InteGrade Pro Server checkbox. If you are turning connectivity on, the 
next time you open the InteGrade Pro software you will need a user ID, password, and server 
address, which you can get from your system administrator.

4. Close the InteGrade Pro software. The changes you made will take effect the next time you open 
the InteGrade Pro software.

Starting the InteGrade Pro Web Software
For instructions on starting and using InteGrade Pro Web, see InteGrade® Pro Web User’s Guide 
Version 9.2.
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Opening Gradebooks on Your Computer
This procedure is for users who do not connect to the InteGrade Pro Server software. It describes 
opening gradebooks stored locally on your computer.

NOTE: Each time you open a gradebook that was created using a previous version of the InteGrade 
Pro software, you will get a message indicating so. You may view the file but if you make any 
changes and save the file, it cannot be opened using earlier versions of the InteGrade Pro 
software.

To Open gradebooks stored locally on your computer:
1. Open the InteGrade Pro software.

2. On the InteGrade Pro banner screen, select Open a gradebook on your computer and click 
OK.

3. Select the folder on your computer where the gradebook is stored.

4. Click on a gradebook file name.

5. Click Open. The gradebook opens and the last spreadsheet edited will is displayed.
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Working with Gradebooks
Opening Gradebooks on the School’s Server
The information and procedures that follow are for users who connect to the InteGrade Pro Server 
software.

NOTE: Each time you open a gradebook that was created using a previous version of the InteGrade 
Pro software, you will get a message indicating so. You may view the file but if you make any 
changes and save the file, it may not be re-opened using earlier versions of the InteGrade Pro 
software.

Preparing the InteGrade Pro Software to Access Gradebooks on the School’s Server
To access gradebooks stored on your school’s server, you must prepare your system to connect to the 
school server. Once you have set up server access, you can open gradebooks on that server.

NOTE: You only need to complete the procedures in this section once for each server to which you 
wish to connect. Once you have completed these procedures, follow the directions in the 
section titled Opening a Gradebook Stored on Your School’s Server.

To connect to the InteGrade Pro Server software:
You must be able to connect to the school’s server.

Your school must be using the InteGrade Pro Server software.

You must have a User ID and Password from your system administrator.

You must have the school’s server IP address or URL information at hand. This information is 
either in an e-mail sent to you by your system administrator or is available by contacting your 
administrator.

You must set up at least one server in your InteGrade Pro software so that you can access 
gradebooks on that server.

If you do not have all of this information, speak to your system administrator. Each of these items is 
described in more detail below.

Connecting to the Server  When you choose to connect your computer to your school’s server, you must 
have a means of communicating with the server. If you are using a computer at school that is 
connected to the server, you are probably connected via network cables.

If you are working on a computer at home, you need some other means of connecting to the remote 
server at your school. You can use an Internet connection that uses either your telephone line or cable 
connection.

Is Your School Using the InteGrade Pro Server Software?  Ask your system administrator if your 
school is using the InteGrade Pro Server software. You may already know this if you have received an 
e-mail containing your user ID and password as well as server address information.

User ID, Password and Server Address Information  You can access gradebooks remotely on your 
school’s server if the school’s system administrator has installed the InteGrade Pro Server software 
and set you up as a user with access to gradebooks.
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When your system administrator configures the InteGrade Pro Server software, he or she adds you as 
a user and creates a user ID and password for you. Your system administrator also assigns access to 
gradebooks.

This illustration shows a Server Connection e-mail:

Hello John Smith:

You have now been registered as a user of an InteGrade Pro Server. This means that you may access remotely stored 
gradebooks using either InteGrade Pro 7.5 or later or InteGrade Pro Web. In order to gain access to the server, you 
have been assigned a user id and password as shown below. This user id and password is the same regardless of 
which method you use to access the server (InteGrade Pro or InteGrade Pro Web):

User ID: jsmith
Password: password

To Access the Server using InteGrade Pro Client:

You must install InteGrade Pro 7.5 or later on your computer. The first time you open the InteGrade Pro software on 
that computer, you must select the option that allows you to access gradebooks on a remote computer. You must then 
add server information (see help topic Adding InteGrade Pro Server Access) if you have not already done so.

You can give the new server any Server Name you wish. The server Address must be set to: "172.16.5.32:3737".

To Access the Server user InteGrade Pro Web:

You must ensure you have an appropriate Web browser installed on your computer and you must have a connection to 
the Internet that operates at a minimum of 28.8 kbps.
When you open your Web browser, type in the following address: http://172.16.5.32:8080.
Note that if you are using InteGrade Pro Web, you must first create the gradebook and all of your classes and students 
using InteGrade Pro. Gradebooks, classes and students cannot be created using InteGrade Pro Web.

If you did not receive an e-mail like this, contact your system administrator for this information.

Once you have your user ID, password and school server’s address information, you can create a 
connection to your school’s server.
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Working with Gradebooks
Adding Server Access – Windows Users
When working on gradebooks remotely you need to have at least one server connection configured in 
your InteGrade Pro software. The connection, which is added using the Open Gradebook screen, 
allows you to connect to a school's InteGrade Pro network where gradebooks are stored. Each time 
you open a gradebook, you connect to the school’s server and then select the gradebook to open.

Some teachers require connections to more than one remote InteGrade Pro Server computer. For 
example, teachers who work at more than one school may need to connect to the server for each school 
when they want to update their gradebooks.

To add a server:
1. Be sure you are connected to the Internet.

2. Open the InteGrade Pro software.

3. From the InteGrade Pro banner screen, select Open a gradebook on a server and click OK. 
The Open Gradebook screen is displayed. This is where you add and remove server access, and 
open gradebooks.

Figure 3-3. Connection to server

4. Click the Servers menu at the top left of the screen, and then click Add Server.
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5. In the Server Name box, enter a name for this server.

The server name can be any name you want for the connection you are configuring. The name 
appears with an icon in the left hand side of the Open Gradebook screen. This name should be 
something that helps you to identify which server the connection is for. For example, if you work 
at two different schools, you would probably use the school names as the server names.

6. In the Address field, enter either an IP address or URL of the server.

The address is either in the format of 999.999.999.999:9999 or www.xxxxxxxxx.xxx:9999, where 
the characters to the left of the colon represent the address of the server and the numbers to the 
right of the colon represent the port number to which you will connect when you access the 
server.

If you do not know the address or did not receive an e-mail with this information, contact your 
system administrator.

7. Click Add to add the new server information. A new icon appears in the left hand side of the 
Open Gradebook screen.

8. Double-click on the new Server icon to ensure that you can connect. Your computer uses either 
your network connection (if you are at school) or uses your pre-configured Internet connection (if 
you are working at home or elsewhere).

9. Enter your user ID and password.

10. If you are working at more than one school, you can set up access to another school by adding 
another server.

Adding Server Access – Macintosh Users
When working on gradebooks remotely you need to have at least one server connection configured in 
your InteGrade Pro software. The connection, which is added to the Open Gradebook screen, allows 
you to connect to a school's InteGrade Pro network where gradebooks are stored. Each time you open 
a gradebook, you connect to the school’s server and then select the gradebook to open.

Some teachers require connections to more than one remote InteGrade Pro Server computer. For 
example, teachers who work at more than one school may need to connect to the server for each school 
when they wish to update their gradebooks.

To add a server:
1. Be sure you are connected to the Internet.

2. Open the InteGrade Pro software.

3. From the InteGrade Pro banner screen, select Open a gradebook on a server and click OK. 
The Open Gradebook screen is displayed. This is where you add and remove server access, and 
open gradebooks.
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Figure 3-4. Connection to server

4. Click the Maintain Servers icon in the upper right of the screen, and then click Add Server.

5. In the Server Name box, enter a name for this server.

The server name can be any name. The name appears with an icon in the left side of the Open 
Gradebook screen. This name should be something that helps you identify which server the 
connection is for. For example, if you work at two different schools, you would probably use the 
school names as the server names.

6. In the Address field, enter either an IP address or URL of the server.

The address is either in the format 999.999.999.999:9999 or www.xxxxxxxxx.xxx:9999, where the 
characters to the left of the colon represent the address of the server and the numbers to the right 
of the colon represent the port number to which you will connect when you access the server.

If you do not know the address or did not receive an e-mail with this information, contact your 
system administrator.

7. Click Add to add the new server information. A new icon appears on the left of the Open 
Gradebook screen.

8. Double-click the server icon to ensure that you can connect. Your computer uses either your 
network connection (if you are at school) or your pre-configured Internet connection (if you are 
working at home or elsewhere).

9. Enter your user ID and password that your system administrator gave to you.

10. If you are working at more than one school, you can set up access to another school by adding 
another server.
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Opening a Gradebook on the Server – Windows and Macintosh Users
This procedure is for opening gradebooks on your school’s server. You can only complete this 
procedure after you have set up access to the school’s server (see “Adding Server Access – Windows 
Users” on page 27).

Once server access has been set up, you can use this procedure on a regular basis for opening 
gradebooks on the server.

To gradebooks on the server:
1. Be sure you are connected to the Internet.

2. Open the InteGrade Pro software.

3. Select Open a gradebook on a server.

4. On the Open Gradebook screen, double-click a Server to connect to it. 

5. After double-clicking the Server icon, you are asked to enter your user ID and password. This is 
the user ID and password assigned to you by your system administrator.

6. Once you have successfully entered a correct user ID and password, a list of available gradebook 
files is displayed on the right hand side of the Open Gradebook screen.

7. If you are working on a Macintosh system, a list of available folders will be displayed and you will 
have to double-click the desired folder to display a list of gradebooks available in that folder. If 
there are no files displayed, speak to your system administrator.

8. Click on the gradebook file you wish to use and click Open. The system updates the gradebook 
with changes from the administration system and downloads the file to your computer. The 
update takes place on the Download Gradebook screen where you can also view messages created 
by your system administrator.

9. Once the download of the gradebook is complete, click OK to open the gradebook.
Copyright © 2005 Pearson School Systems InteGrade® Pro User’s Guide, rev. July 8, 2005

30



Working with Gradebooks
Viewing Another Teacher’s Gradebooks – Windows and Macintosh Users
If system administrator has granted you access to other teachers' gradebooks, you can open and view 
gradebooks for those teachers.

To view another teacher’s gradebooks:
1. Be sure you are connected to the Internet.

2. Open the InteGrade Pro software and select Open a gradebook on a server.

3. Double-click a server and log in.

4. From the Teacher list, select the name of the teacher whose gradebooks you want to see. If a 
teacher is not displayed there, you do not have access to that teacher's gradebooks. Speak to your 
system administrator.

If you are working on a Macintosh system, other teachers’ folders are displayed under the server 
name and you can double-click on the desired folder.

5. Select the gradebook you want to view and click Open. The gradebook opens. Depending on the 
type of access you have, you may or may not be able to make changes to the information. This is 
controlled by your system administrator.
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Opening Gradebooks Locally – Windows and 
Macintosh Users
Even if you configured your system to access gradebooks stored remotely on your school’s server, you 
can still save and open a gradebook locally if you wish, using this procedure.

NOTE: Each time you open a gradebook that was created using a previous version of the InteGrade 
Pro software, you get a message indicating so. You can view the file but if you make any 
changes and save the file, you cannot open it using earlier versions of the InteGrade Pro 
software.

To open gradebooks locally:
1. Open the InteGrade Pro software.

2. On the InteGrade Pro banner screen, select Open a gradebook on your computer and click 
OK.

3. On the Open screen, select the folder on your computer where the gradebook is stored.

4. Click a gradebook file name.

5. Click Open. The gradebook opens and the last spreadsheet edited will is displayed.
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Saving Gradebooks

Saving Automatically
You can choose to have your data saved automatically at regular intervals.

To save gradebooks automatically:
1. From the Edit menu, select Preferences.

Figure 3-5. Preferences dialog box

2. Select how often you want your gradebook saved. You can choose any interval from 3–30 minutes.

3. Click OK. These autosaved gradebooks are saved locally regardless of whether you normally 
connect to the InteGrade Pro Server software or not.

Saving Gradebooks with Another Name or in Another Location – Windows and 
Macintosh Users
Use this procedure to save a gradebook with a different name or to save the gradebook to a different 
location (for example, saving a locally-stored gradebook to the school’s server).

To save gradebooks with another name or in another location:
1. Be sure you are connected to the Internet.

2. Open the gradebook.

3. On the File menu, select Save As.
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4. On the Save As screen, 

If you are saving an existing gradebook locally but with another name, click the Local button. 
This will take you to the regular Save As screen where you can select a new folder location and 
type in a new name for the gradebook.

To save the gradebook back to the remote server but with a different name, connect to the 
server, enter the name in the Name field and click Save. The gradebook will be saved with the 
new name on the currently connected remote server.

To save the gradebook to a different server, you must have already set up server access. Once 
the server has been added, you can double click on it to connect to it and then save the 
gradebook in the desired folder on that server.

Closing Gradebooks

To close a gradebook on your computer:
1. From the File menu, select Close Gradebook.

2. If you are asked to save changes, click Yes to save changes.

3. The gradebook is saved locally on your computer to the same folder from which it was opened.

Closing a Gradebook on the InteGrade Pro Server Software
If you are storing gradebooks remotely on your school’s server, closing a gradebook does two things: It 
saves changes to the gradebook and copies the gradebook to your school's InteGrade Pro Server 
software.

To close a gradebook on the InteGrade Pro Server software:
1. From the File menu, select Close Gradebook.

2. If you are asked to save changes, click Yes. The gradebook is saved and copied back to your 
school's server.

3. Open another gradebook or select Exit from the File menu to leave the system.

Reverting to an Earlier Version of the Gradebook
From the File menu, select Revert to Saved. The current version closes and the last version that you 
saved opens.
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Creating Gradebooks - Windows Users
If you would like to create a gradebook template to be used each time a a new gradebook is created, 
see “Using Gradebook Templates” on page 42

Creating a New Gradebook on Your Computer
This procedure is for Windows users who do not connect to the InteGrade Pro Server software.

Creating a new gradebook on your computer using class rosters:
1. Open the InteGrade Pro software and on the InteGrade Pro banner screen, select Create a new 

gradebook. The first screen of the new gradebook wizard is displayed.

2. Click Next.

3. Select Create using class rosters and click Next.

4. Click Next after reading about creating a gradebook using class rosters. The Import File screen is 
displayed.

5. On the Import File screen, select the class roster file to use when creating the gradebook. The 
class roster file must be accessible to complete the import.

6. Click Open. A confirmation screen appears asking you to verify that the information in the 
selected class roster file is correct.

7. Click Next.

8. Make desired edits to the Teacher Name and Incomplete Symbol fields.

9. Use Set Password to assign a password to the gradebook. See “Passwords” on page 20 for more 
information.

10. Click Save. The class roster information is imported into the new gradebook file and the Save As 
screen is displayed.

11. Select the folder to store the gradebook in and in the File Name field enter a name for the new 
gradebook.

12. Click Save. The gradebook is saved with the new name and displayed in the class viewer.
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Creating a new gradebook on your computer without classes or students:
1. Open the InteGrade Pro software and on the InteGrade Pro banner screen, select Create a new 

gradebook and click OK. The first screen of the new gradebook wizard is displayed.

2. Click Next.

3. Select Create without classes or students and click Next.

4. Make desired edits to the Teacher Name and Incomplete Symbol fields.

5. Use Set Password to assign a password to the gradebook. See “Passwords” on page 20 for more 
information.

6. Click Save. The new blank gradebook will be created and the Save As screen will be displayed.

7. Select the folder to store the gradebook in and in the File Name field enter a name for the new 
gradebook.

8. Click Save. The gradebook is saved with the new name and displayed in the class viewer.

Creating a Gradebook on the InteGrade Pro Server Software
This procedure is for Windows users who connect to the InteGrade Pro Server software.

With this procedure you can create a gradebook at the beginning of the reporting period or any time 
throughout the reporting period. The new gradebook automatically imports available class roster file 
information and the gradebook is stored remotely on your school's server.

To create a gradebook on the InteGrade Pro Server software:
1. Be sure your Internet connection is active.

2. Open the InteGrade Pro software.

3. On the InteGrade Pro banner screen, select Create a new gradebook and click OK.

4. Click Next on the first screen of the New Gradebook wizard. The New Gradebook screen appears.

5. On the New Gradebook screen, double-click the Server icon where you want to save the new 
gradebook. If you do not have any servers configured, see “Adding Server Access – Windows 
Users” on page 27 or “Adding Server Access – Macintosh Users” on page 28.

6. Log in to the server with your user ID and password. If you have forgotten these, speak to your 
system administrator. Once you are successfully logged onto the school server, available 
gradebooks are displayed.

7. In the File Name field, enter a name for the new gradebook. Make sure the name is unique.

8. Click New. The system downloads import files and the next screen in the New Gradebook wizard 
is displayed.

9. Enter your name in the Teacher Name field. This name is used on reports and e-mails.

10. Enter the Incomplete Symbol value. This is the symbol to be used for identifying incomplete 
scores.

11. Click Save. The gradebook is created, class roster files are imported and the gradebook is 
displayed in the class viewer.
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Creating a Gradebook Locally When Connected to the InteGrade Pro Server Software
This procedure is for Windows users who normally connect to the InteGrade Pro Server software but 
wish to save a gradebook locally.

You can create the new gradebook using class rosters exported from your administration system or 
you can create the new gradebook without students or classes. Select one of the following procedures.

To create a new gradebook locally using class rosters:
1. Open the InteGrade Pro software. You do not need to be connected to the Internet for this 

procedure.

2. On the InteGrade Pro banner screen, select Create a new gradebook and click OK.

3. On the first screen of the New Gradebook wizard, read the information and click Next.

4. Click the Local button.

5. Select Create using class rosters and click Next.

6. Click Next after reading about creating a gradebook using class rosters. The Import File screen is 
displayed.

7. On the Import File screen, select the class roster file to use when creating the gradebook. The 
class roster file must be accessible to complete the import.

8. Click Open. A confirmation screen appears asking you to verify that the information in the 
selected class roster file is correct.

9. Click Next.

10. Make desired edits to the Teacher Name and Incomplete Symbol fields.

11. Use Set Password to assign a password to the gradebook. See “Passwords” on page 20 for more 
information.

12. Click Save. The class roster information is imported into the new gradebook file and the Save As 
screen is displayed.

13. Select the folder to store the gradebook in and in the File Name field enter a name for the new 
gradebook.

14. Click Save. The gradebook is saved with the new name and displayed in the class viewer.
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To create a new gradebook locally without classes or students:
1. Open the InteGrade Pro software. You do not need to be connected to the Internet for this 

procedure.

2. On the InteGrade Pro banner screen, select Create a new gradebook and click OK.

3. On the first screen of the New Gradebook wizard, read the information and click Next.

4. Click the Local button.

5. Select Create without classes or students and click Next.

6. Make desired edits to the Teacher Name and Incomplete Symbol fields.

7. Use Set Password to assign a password to the gradebook. See “Passwords” on page 20 for more 
information.

8. Click Save. The new blank gradebook is created and the Save As screen is displayed.

9. Select the folder to store the gradebook in and in the File Name field enter a name for the new 
gradebook.

10. Click Save. The gradebook is saved with the new name and displayed in the class viewer.
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Creating Gradebooks – Macintosh Users
If you would like to create a gradebook template to be used each time a a new gradebook is created, 
see “Using Gradebook Templates” on page 42

Creating a New Gradebook on Your Computer
This procedure is for Macintosh users who do not use the InteGrade Pro Server software. When you 
first opened the InteGrade Pro you selected an installation option. If you selected to save gradebooks 
locally, use this procedure to create gradebooks.

To create a new gradebook on your computer using class rosters: 
1. Open the InteGrade Pro software.

2. On the InteGrade Pro banner screen, select Create a new gradebook and click OK. The first 
screen of the new gradebook wizard is displayed.

3. Click Next.

4. Select Create using class rosters and click Next.

5. Click Next after reading about creating a gradebook using class rosters. The Import File screen is 
displayed.

6. Select the class roster file to use when creating the gradebook. The class roster file must be 
accessible to complete the import.

7. Click Open. A confirmation screen appears asking you to verify that the information in the 
selected class roster file is correct.

8. Click Next.

9. Make desired edits to the Teacher Name and Incomplete Symbol fields.

10. Use Set Password to assign a password to the gradebook. See “Passwords” on page 20 for more 
information.

11. Click Save.

12. Select the folder to store the gradebook in and in the Save file name field enter a name for the 
new gradebook.

13. Click Save. The gradebook is saved with the new name and displayed in the class viewer.
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To create a new gradebook on your computer without classes or students:
1. Open the InteGrade Pro software.

2. On the InteGrade Pro banner screen, select Create a new gradebook and click OK. The first 
screen of the new gradebook wizard is displayed.

3. Click Next.

4. Select Create without classes or students and click Next.

5. Make desired edits to the Teacher Name and Incomplete Symbol fields.

6. Use Set Password to assign a password to the gradebook. See “Passwords” on page 20 for more 
information.

7. Click Save.

8. Select the folder to store the gradebook in and in the Save file name field enter a name for the 
new gradebook.

9. Click Save. The gradebook is saved with the new name and displayed in the class viewer.

Creating a New Gradebook on the InteGrade Pro Server Software
This procedure is for Macintosh users who connect to the InteGrade Pro Server software.

With this procedure you can create a gradebook at the beginning of the reporting period or any time 
throughout the reporting period. The new gradebook automatically imports available class roster file 
information and the gradebook is stored remotely on your school's server.

To create a gradebook on the InteGrade Pro Server software:
1. Open the InteGrade Pro software.

2. On the InteGrade Pro banner screen, select Create a New Gradebook and click OK.

3. Click Next on the first screen of the New Gradebook wizard. The Create Gradebook screen 
appears.

4. On the Create Gradebook screen, double-click a Server icon where you wish to save the new 
gradebook. If you do not have any servers configured, see Setting up Access to InteGrade Pro 
Server.

5. Log in to the server with your user ID and password. If you have forgotten these, speak to your 
system administrator. If this is your first time logging in, you may be prompted to change your 
password. Once you have successfully logged onto the school server, all the folders to which you 
have access are displayed. These include your folder and the “Common Folder” (stores all the 
template files). Navigate to the folder you wish to store the new gradebook file in.

6. In the Save File Name field, enter a name for the new gradebook. Make sure the name is 
unique.

7. Click Save. The system downloads import files and the next screen in the New Gradebook wizard 
is be displayed.

8. Enter your name in the Teacher Name field. This name is used on reports and e-mails.
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9. Enter the Incomplete Symbol. This is the symbol to be used for identifying incomplete scores.

10. Click Save. The gradebook is created, class roster files imported and the gradebook is displayed 
in the class viewer.

Creating a New Gradebook Locally
This procedure is for Macintosh users. Use it only if you configured the InteGrade Pro software to 
connect to the school's server but you wish to save a gradebook locally. If you did not set the 
InteGrade Pro software to connect to the InteGrade Pro Server software and you always save 
gradebooks on your computer, “Creating a New Gradebook on Your Computer” on page 35.

If you wish to create a gradebook and store it remotely on the school's network server, “Creating a 
Gradebook on the InteGrade Pro Server Software” on page 36

You can create the new gradebook using class rosters exported from your administration system or 
you can create the new gradebook without students or classes. Select one of the following procedures.

To create a new gradebook locally using class rosters:
1. Open the InteGrade Pro software. 

2. On the InteGrade Pro banner screen, select Create a New Gradebook and click OK. 

3. On the first screen of the New Gradebook wizard, read the information and click Next.

4. Click the Local button.

5. Select Create using class rosters and click Next.

6. Click Next after reading about creating a gradebook using class rosters. The Import File screen is 
displayed.

7. On the Import File screen, select the class roster file to use when creating the gradebook. The 
class roster file must be accessible to complete the import.

8. Once you have selected the file to use, click Open. A confirmation screen will appear asking you 
to verify that the information in the selected class roster file is correct.

9. Click Next.

10. Make desired edits to the Teacher Name and Incomplete Symbol fields.

11. Click Save. The class roster information is imported into the new gradebook file and a saving file 
screen is displayed.

12. Select the folder to store the gradebook in and in the Save file name field enter a name for the 
new gradebook.

13. Click Save. The gradebook is saved with the new name and displayed in the class viewer.
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To create a new gradebook without classes or students:
1. Open the InteGrade Pro software.

2. On the InteGrade Pro banner screen, select Create a New Gradebook and click OK.

3. On the first screen of the New Gradebook wizard, read the information and click Next.

4. Click the Local button.

5. Select Create without classes or students and click Next.

6. Make desired edits to the Teacher Name and Incomplete Symbol fields.

7. Click Save.

8. Select the folder to store the gradebook in and in the Save file name field enter a name for the 
new gradebook.

9. Click Save. The gradebook is saved with the new name and displayed in the class viewer.

Using Gradebook Templates
When you create a gradebook, the InteGrade Pro software searches for a template gradebook whose 
contents and option settings will be included in the new one. This template file must be named 
template.gbf.

Subsequent imports of administrative data will only overwrite the INC symbol and grade tables with 
the same name. All other data remains unchanged in the gradebook.

Although anyone can create a template gradebook, it is generally the system administrator who is 
responsible for creating the template.

Location of Gradebook Template Files
Template files used on a client connected to the InteGrade Pro Server software must be stored in one 
of the following folders:

In the same folder as your class roster file.

In the parent folder of the folder containing the class roster file.

In the IGPDATA “_Common” folder.

In the InteGrade Pro software application folder.

Template files used for local and network imports must be stored in one of the following folders:

In the same folder as your class roster file.

In the parent folder of the folder containing the class roster file.

In the InteGrade Pro software application folder.
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Creating a Template Gradebook and Template Classes

To create a template gradebook and template classes:
1. Create a new gradebook without importing any class roster files. 

2. Set the options for Display, Grading Rules, and any other standard settings required by the 
teachers who will be using this template. You do not need to include students or classes.

3. Add default classes. For example if you want every gradebook to have a Math and an English 
class, create default classes for each of these. Each time a gradebook is created using the 
template, the gradebook will automatically contain the default classes.

4. Add a template class if you wish. You can create a template class that includes standard 
spreadsheets that you want applied to the creation of any new classes that are imported. For 
example, you can create a template class labelled “template” and add several spreadsheets to it. 
Then each time a user imports classes from the class roster file using the template file, each 
imported class will have those template spreadsheets added to it.

5. Save the gradebook as template.gbf. Be sure to store the gradebook in the appropriate location 
for the type of system being used. See the previous section.

Data Copied when a Template Is Used
All settings of the template gradebook will be copied to gradebooks created using the template. These 
settings include:

All display settings.

All grading rules.

Default students. Students added via template will be considered manually added unless 
subsequently imported.

Default classes. Classes added via template will be considered manually added unless 
subsequently imported.

Any template classes you created.

Report settings.

The following data copied from the template gradebook is overwritten each time information is 
imported from an administration system:

The incomplete symbol.

Any grade tables with the same name.
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Renaming Gradebooks

To rename gradebooks for Windows:
1. Open the InteGrade Pro software.

2. Start the process for opening a gradebook

3. On the Open gradebook screen, right-click on the gradebook name you want to change.

4. Select Rename from the right-click menu.

5. Type in the new name and press Enter. The name of the gradebook is changed.

To rename locally stored gradebooks for Macintosh:
1. From the desktop, open the InteGrade Pro folder where your gradebooks are stored.

2. Click on the gradebook whose name you want to change.

3. Click on the name portion of the gradebook icon.

4. Delete the existing name and type in a new name.

NOTE: You can also open and gradebook and select the Save As option from the File menu. This 
enables you to save a file with a different name. If you do this, you will have two copies of the 
file: one with the original name and one with the new name.

To rename remotely stored gradebooks for Macintosh:
1. Open the InteGrade Pro software.

2. Start the process for opening a gradebook on a remote server.

3. On the Open Gradebook screen, click the gradebook to rename.

4. Click the Toolbox icon in the upper right corner of the screen and select Rename.

5. In the Rename field, type a new name for the gradebook and click Rename. The name of the 
gradebook is changed and your list of gradebooks refreshed.
Copyright © 2005 Pearson School Systems InteGrade® Pro User’s Guide, rev. July 8, 2005

44



Working with Gradebooks
Gradebook Sample Data
The InteGrade Pro software comes with a sample class loaded with data that you can use to 
experiment. This sample class is available whether you are running the demonstration or an 
authorized version of the software. 

To access the sample class:
1. Open a gradebook locally on your computer.

2. Select SAMPLE.GBF from the Open Gradebook. The sample class loads. If you cannot find the 
sample gradebook, speak to your system administrator.

3. Try the menu commands. View the Help menu. Enter or change data.

4. When you have finished working with the sample data, select Close Gradebook from the File 
menu. To preserve the sample data for the next time, be sure to select No when asked to save 
changes.

Importing Data to a Gradebook 
Importing data is the preferred method of adding students and classes to your gradebook. Only by 
importing data from your school’s administration system can you electronically export data back to 
the main office at the end of a term.

Importing Rosters, Comments, or Scores
The class roster file is the central piece of information imported. For class rosters, the import process 
brings demographic data, letter grade tables, and other data associated with the student and class 
rosters. The exact information imported can vary depending on the administration system providing 
the data.

When importing from a CLxxxxx.GRD file, gradebook fields that contain data are not overwritten by 
administration system data unless your administrator has set the system to do so. When the 
administrative system overrides are turned on, the following data in the gradebook is overwritten:

Student Demographics: Any student demographic field with the exception of the Advanced 
fields.

Advanced Fields: Any field in the Advanced Fields section of the Classes, Communication, and 
Students screens.

Type Sets: Any field in a Type or Type Set.
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To import Rosters, Comments, or Scores:
1. Open the InteGrade Pro software.

2. Open the gradebook into which you want to import data.

3. From the File menu, choose Import into Gradebook.

4. Select the file and click Import.

Most people import at the beginning of the school year, but you can run the import process at any 
time. For example, if many students transfer into your classes, the main office can give you an import 
file to update your gradebook. This file adds new information to your gradebook, but does not change 
existing information.

Importing Tasks, Spreadsheets, or Classes
This feature of the InteGrade Pro software lets you import one or more tasks, spreadsheets, or classes 
from another gradebook into your own. 

To import tasks, spreadsheets, or classes:
1. Open the InteGrade Pro software.

2. From the Task Menu, select Import Tasks. 

3. On the Import Tasks screen, click Save Gradebook Now, then click Next.

4. Select the gradebook file you want to import from and click Open.

5. Choose whether you want to import classes, spreadsheets, or tasks and click Next. You can 
import tasks only from numeric or skill spreadsheets.

6. Select the specific items you want to import from that gradebook to yours. Use the All and None 
buttons to quickly select and deselect.

7. Click Import.

When Importing From Other Products
The InteGrade Pro software can work with data from the following Pearson School Systems products:

SASIxp™ educational software

SASI III™ software

CIMS® software

TSS/TESS™ software

Osiris® software

For complete details of importing from and exporting to other products, please see InteGrade® Pro 
Administrator’s Guide Version 9.2.

The NCS ABACUSxp™ Software  Before you can import an NCS ABACUSxp™ file, you must import a 
related SASIxp CLxxxxxx.GRD file.
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Previous Versions of the InteGrade Pro Software  Users of previous versions of the InteGrade Pro 
software can open their gradebooks using the current version. However, once you save a previous 
version gradebook using the current version, you cannot reopen the gradebook in its original version.

The CIMS Student Software  If you are using the CIMS student software as your administration 
system, you need to convert files from the CIMS format into the InteGrade Pro software format using 
the InteGrade Pro/CIMS File Converter before importing. See the InteGrade Pro System 
Administrator’s Guide on Customer Link for instructions on using this converter.

The TSS Software  When data is imported from TSS, the student status may be changed in certain 
cases where the student is not in a TSS class list. The following table shows the results of importing 
data from TSS.

Reviewing Imported Data 
After importing student and class data, you should confirm that the data has transferred correctly 
into your gradebook.

Look for fields that are blank when you know that there should be data, or fields that show 
unrecognizable characters. If you find any indication of corrupt or missing data, close the gradebook 
without saving or delete the corrupt data. Begin the import process again with a new file provided by 
your system administrator.

Table 3-1. Results of importing data from TSS

TSS Status InteGrade Pro Status

Previously Active Previously Inactive

In Class List Leaves student in active 
status

Changes student to active, but 
leaves the inactive notes

Not in Class List Changes student to inactive 
status

Leaves student in inactive 
status
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To review student data:
1. Open the InteGrade Pro software.

2. From the Setup menu, select Students.

3. Review the list of students in the Students screen.

4. Click on several students at random and review the tabs to the right of the list. Importing does 
not fill in every field for all tabs. You can enter additional student information at this time.

5. Click Close when you are finished reviewing.

When you add students to the new class, the InteGrade Pro software looks for existing classes for 
that student. The system determines whether existing classes are similar to the new class. If a 
match is found, the system copies the task scores and notes information to the new class. The 
procedure is completed automatically each time you add a student to a class. If the system is 
unable to match information, nothing is copied, and you must add the student's scores and note 
information manually to the new class.

This auto copy feature copies numeric spreadsheet, skill spreadsheet, End Term spreadsheet, and 
attendance spreadsheet information.

To review class data:
1. Open the InteGrade Pro software.

2. From the Setup menu, select Classes.

3. Review the list of classes in the Classes screen. 

4. Review the tabs for several of the classes. Check that the Students tab contains the number of 
students that you expect to have in that class. You can enter additional class information at this 
time.

5. Click Close when you are finished reviewing.

Importing Automatically from Your Administration System
When you install the InteGrade Pro software, you can choose to automatically update your gradebook 
every time you open it. You can also choose to do this from within the system. To update the 
gradebook automatically when the gradebook is stored locally on your computer, you must have 
access to the class roster file for the update to be completed successfully.

If you are using the InteGrade Pro software to connect to the InteGrade Pro Server software, this 
update occurs automatically every time you open a gradebook that is stored remotely on the server.

Before you can receive automatic updates from your administration system, you must first import a 
class roster file from the administration system.

You can receive automatic updates from the administration system only if your computer and the 
administration system are connected through a network.
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To automatically update your gradebook every time you open it:
1. Open the gradebook into which you want to import data.

2. From the Edit menu, select Preferences.

3. Select Update Gradebooks Automatically and click OK.
Figure 3-6. Preferences dialog box

If this feature is selected, when you open a gradebook, the system searches for the latest 
CLxxxxxx.GRD file exported by the administration system. This file imports data to update class 
rosters, class and student information, and inactive students. A progress bar displays indicating 
the status of the automatic update. When an automatic update finishes, a message displays 
stating that the process is complete.

When importing from a CLxxxxx.GRD file, gradebook fields that contain data are not overwritten by 
administration system data unless your administrator has set the system to do so. When the 
administrative system overrides are turned on, the following data in the gradebook is overwritten:

Student Demographics: Any student demographic field with the exception of the Advanced 
fields.

Advanced Fields: Any field in the Advanced Fields section of the Classes, Communication, and 
Students screens.

Type Sets: Any field in a Type or Type Set.

If you are using a Windows-based computer on your school’s network and you do not connect to 
the InteGrade Pro Server software, you must choose your import file from a mapped network 
drive. It must start with a drive letter (for example, G:\igpro\CLxxxxxx.grd.) 

If you need to run the product on a stand-alone computer, you can switch off the network feature. 
When you want to go back to the network, you can switch it back on.

It doesn’t matter whether the InteGrade Pro software links to an administration system via a 
network or if you run both this system and your administration system from a stand-alone computer. 
The InteGrade Pro software must be able to find the class roster file for the update to work.
Copyright © 2005 Pearson School Systems InteGrade® Pro User’s Guide, rev. July 8, 2005

49



Working with Gradebooks
Error Messages
If the system cannot find the location of your class roster file to update the gradebook, the 
following message displays:

InteGrade Pro was not able to update your gradebook because it could not find 
the following location:

NOTE: The path the system is looking for displays (for example, C:\igpdata). Click Browse to specify 
another location or select the checkbox to work off-line.

If the system cannot find a class roster file corresponding to the gradebook file being opened, 
the following message displays:

InteGrade Pro was unable to update your gradebook because it could not find a 
class roster file for your gradebook in the following location:

NOTE: The path the system is looking for displays (for example, C:\igpdata). If you cannot find the 
correct path, contact your network administrator.

If the system cannot update your gradebook for some reason (for example, the network 
connection is down), you can still open your gradebook. If this happens, the following message 
displays:

InteGrade Pro was unable to update your gradebook because it found problems 
importing a class roster file from your administration system.

NOTE: Contact your network administrator for help in updating your gradebook.
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Setting Up Grading Rules
Use the Grading Rules screen to set up attendance codes, grade tables, special scores, and type sets. 

Setting Up Attendance Codes
Use attendance codes to explain why a student is absent. If you created a gradebook by importing a 
class roster file from an administration system, you must use the existing system codes, so that the 
file exports correctly.

This table lists the system codes and their late and absent values. These codes are used in the Class 
Attendance report and the Student Attendance report where the summaries list Late, Absent, and 
Present. For example, a Tardy and an Excused Tardy both are included in the Late category, and an 
Excused counts as an Absent. If you create a new attendance code, you must assign one of these 
system codes to it, so that those reports are created correctly.

Table 3-2. System codes

Code Late Absent

Activity 0 0

Dismissed 0 0.5

Excused 0 1

Excused Tardy 1 0

Not Enrolled 0 0

Present 0 0

Suspended 0 1

Tardy 1 0

Undefined 0 0

Unexcused 0 1

Unexcused Tardy 1 0

Unverified 0 1
Copyright © 2005 Pearson School Systems InteGrade® Pro User’s Guide, rev. July 8, 2005

51



Working with Gradebooks
To set up attendance codes:
1. Open the InteGrade Pro software.

2. From the Setup menu, select Grading Rules.

3. Click the Attendance Codes tab.
Figure 3-7. Attendance Codes tab

4. Review the existing codes. These default codes are either provided by the product or imported 
from your administration system when you import a class roster file.

5. If necessary, click New to create a new attendance code. 

If you create a new attendance code in a gradebook created by importing a class roster file from 
an administration system, you must assign one of the existing system codes to it.

If you create a new attendance code in a gradebook that was manually created, you must 
assign one of the default system codes to it.

6. Click Close. 
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Setting Up Grade Tables
Grade tables are assigned to individual numeric spreadsheets. When InteGrade Pro is looking up a 
letter grade, it will search the grade table and determine which effective range matches the student’s 
percentage.

The InteGrade Pro software comes with three default grade tables.

To set up grade tables:
1. Open the InteGrade Pro software.

2. From the Setup menu, select Grading Rules.

3. Click the Grade Tables tab.
Figure 3-8. Grade Tables tab

On the left side of this screen is a list of grade tables. Each grade table consists of a list of letter 
grades and lower limits. You can select each sample grade table and review its letter grades.

To create a new grade table, click the New button from the set of buttons under the Grade 
Tables list. Type the name of your new grade table and click Create.

To create a grade table by copying an existing table, select a table and click Copy. Your new 
grade table has “copy” at the end of its name.

To rename an existing grade table, select the table and type its new name in the Grade Table 
Name field.

On the right side of this screen is the list of letter grades associated with the selected grade table. 
When InteGrade Pro looks up a letter grade for a student, it searches for the Effective Range within 
which the student’s percentage lies. 
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Zeroes after the decimal point matter. For example:

If your lower limit for A is 90% an A will start at 89.5%.

If you change this lower limit to 90.0%, an A will start at 89.95%.

If you change this lower limit to 90.00%, an A will start at 89.995%.

If you change this lower limit to 90.000%, an A will start at 89.9995%.

With a lower limit including three decimals, your grading lookup is accurate to 1 question in 2,000.

To create a new letter grade, click the New button from the set of buttons under the Letter 
Grade and Lower Limit area. With that cell selected, type the letter, then select the adjoining 
cell and type the lower limit for that grade.

To modify one of the existing grades, select that cell and overwrite its contents.

To sort the grade table from highest to lowest percentage, click the Sort button from the set of 
buttons under the Letter Grade and Lower Limit area.

Display Decimals is unrelated to letter grade lookup. This setting affects how many decimals are 
display on the main spreadsheet. The rounding rules as describe previously are used for the actual 
Letter Grade lookup.

When you’re done, click Close. The table is now available for use, but it is not saved until you save 
the gradebook.

Setting Up Special Scores
A special score is a numeric score represented by a text label.

To set up special scores:
1. Start the InteGrade Pro software.

2. From the Setup menu, select Grading Rules. Click the Special Scores tab.
Figure 3-9. Special Scores tab
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3. Review the special scores that are already predefined for your convenience.

To modify the score for any of the predefined special scores, select the score and type its new 
value in the Score Value field.

To modify the name for any of the predefined special scores, select the score and type the new 
name in the Score Symbol field.

To create a new special score, click New, type a name, and define the value.

To delete a special score, select the score, click Delete, and click Yes to confirm the deletion.

4. Review the symbol used to indicate an incomplete score. The default is INC.

5. Click Close.
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Setting Up Type Sets
Type sets let you group task types into categories. The system comes with sets already defined.

You assign a type set to a particular class when you select Classes from the Setup menu

To set up type sets:
1. Start the InteGrade Pro software.

2. From the Setup menu, select Grading Rules.

3. Click the Type Sets tab and review the list of types (Homework, Exam, Quiz).
Figure 3-10. Type Sets tab
.

4. To create a new type, click New Type, type its name, and click Create. The type displays in the 
list at the left.

5. Review the sets (Humanities, Science, Elementary).

6. To create a new set, click New Set, type its name, and click Create. The set displays as a column 
heading across the top of the screen.

7. To add a type to a set, enter a numerical weight in the appropriate cell in the Type Set chart. You 
do not need to assign all the sets you create. The numbers do not have to total 100.

8. Click Close.

Modifying Type Sets  First, select a cell in the grid to choose the type or set to modify.

To rename a Type, click Rename Type, enter the new name, and click Rename.

To rename a Set, click Rename Set, enter the new name, and click Rename.

To delete a Type, click Delete Type. Click Yes to confirm the deletion or No to cancel this 
action.

To delete a Set, click Delete Set. Click Yes to confirm the deletion or No to cancel this action.
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Adding Students 
If you manually created a gradebook, you can manually enter data at any time after creating the 
gradebook. If your gradebook was created automatically from class roster files, it is updated by them 
automatically as well.

To add students:
1. Open the InteGrade Pro software.

2. From the Setup menu, choose Students.

3. Click New, then click Next.

4. Enter the student’s first and last name and student number. The name is a required field. 

5. Click Next.

6. Select the class or classes to which you want to add the student. Use the All or None buttons to 
speed up your selection. If a class is not there, you will have to add it and return to this step later.

7. Click Create.

8. Repeat Steps 2-6 for all remaining students. 

9. Click Close.

NOTE: If you select Show Advanced Fields, you see information used when the InteGrade Pro 
software shares data with another software program. You should not change the information 
in these fields. If you need to change the field information, contact your System 
Administrator.
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Adding Classes 

To add classes:
1. Open the InteGrade Pro software.

2. From the Setup menu, choose Classes.

3. Click New, then click Next.

4. Type the class name and click Next.

5. Select a task type set from the drop-down list and click Next.

6. Select the students registered in this class. Use the All or None buttons to speed up your 
selection. If a student is not there, you will have to add them and return to this step later.

When you add students to the new class, the InteGrade Pro software looks for existing classes 
with that student. The system also determines whether these existing classes are similar to the 
new class. If a match is found, the system copies the task scores and notes information to the new 
class. The procedure is completed automatically each time you add a student to a class. If the 
system is unable to match information, nothing is copied and you must add the student's scores 
and note information manually to the new class.

This auto copy feature copies numeric spreadsheet, skill spreadsheet, End Term spreadsheet, and 
attendance spreadsheet information.

7. Click Next.

8. On the New Class screen, select the spreadsheets you want created and click Create.

9. Repeat Steps 2–7 for all classes.

10. Click Close when you are finished.

NOTE: If you select Show Advanced Fields, you see information used when the InteGrade Pro 
software shares data with another software program. If you click the padlock icon, you can 
change the information in these fields. However you should do so only under the direction of 
your system administrator.
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Working Securely

Using Gradebook Passwords
Security is important when dealing with confidential matters such as student grades. If you are 
storing your gradebooks locally on your computer, Pearson School Systems recommends that you set 
up a gradebook password to prevent unauthorized access to your gradebook file. If you are storing 
your gradebooks on the school’s server, your network login password protects your gradebook files 
from unauthorized access by other users.

When using gradebook passwords, consider the following:

Leave your password with the school office, in case you forget it or are absent and a substitute 
teacher needs access to your class files.

Avoid writing down your password and leaving it where someone else can find it.

Delete password protection just before archiving your gradebook file. You should remove the 
password so that others can access the file in the future.

When creating gradebook passwords, avoid obvious ones such as your initials, or the names of your 
children, pet, or spouse. Consider mixing digits and characters to form recognizable words, such as 
4EST (forest), or XLR8 (accelerate), or 4MUL8 (formulate). Another secure method is to link common 
words with a special character. For example, WORK+LATE, or EAT-LUNCH. This type of password 
is easy to remember, but very hard to guess.

NOTE: If you experience problems accessing your gradebook with your gradebook password or you 
forget your gradebook password, call Pearson School Systems Technical Support at (800) 
282-4490 for assistance.

Setting up a New Gradebook Password
You can only complete this procedure for gradebooks stored locally on your computer. If your 
gradebooks are stored remotely on the school’s server, you can change your network login password. 
Changing your login password will accomplish the same level of security for your files as having a 
gradebook password.

To set up a new gradebook password:
1. Open a gradebook file that is stored locally on your computer.

2. From the Setup menu, select Password.

3. Type your password and click Next. 

4. Type your password again to confirm it and click Next. 

5. Click OK to set the password.
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Changing a Gradebook Password
You can only complete this procedure for gradebooks stored locally on your computer. If your 
gradebooks are stored remotely on the school’s server, you can change your network login password. 
Changing your login password will accomplish the same level of security for your files as having a 
gradebook password.

To change a gradebook password:
1. Open the InteGrade Pro software.

2. From the Setup menu, select Password.

3. Type your password and click Next.

4. Select Change password to.

5. Type the new password and click Next.

6. Type your password again to confirm it and click Next.

7. Click OK.

Deleting a Gradebook Password

To delete a gradebook password:
1. From the Setup menu, select Password.

2. Type your password and click Next.

3. Select Remove password protection and click Next.

4. Click OK.
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Changing Your Network Login Password
If you are using the InteGrade Pro software connected to the InteGrade Pro Server software 
(network), you can change your network access password any time you wish. Pearson School Systems 
recommends that you change your password from time to time to maintain system security.

NOTE: This does not apply a password to a gradebook. For teachers who are working remotely using 
the server functionality of the InteGrade Pro software, there is no gradebook password 
feature. Your network password is sufficient for system security. For users who are not using 
the server functionality of the InteGrade Pro software, you can still assign a password to 
gradebooks using the procedure for creating gradebook passwords.

To change your network login password (not a gradebook password):
1. Open any gradebook.

2. On the Setup menu, select Password.

3. On the first Password screen, enter your current password and click Next.

If you have just logged on and the system has prompted you to change your password, this first 
screen is not displayed and you can go to step 4).

4. On the Next screen, enter a New Password.

5. On the next screen, enter the New Password again to confirm it and click Next.

6. On the Password verification screen, click OK to complete the process.

The next time you attempt to connect to the server, you must use your new password.
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Locking a Gradebook
You can lock your gradebook quickly, to prevent unauthorized viewing and access. The password you 
use to unlock a gradebook depends on how you are using the InteGrade Pro software. If you connect to 
the InteGrade Pro Server software, use your network login password. If you only store gradebooks 
locally, use the gradebook password.

To lock a gradebook:
1. From the Setup menu, select Lock Gradebook, or press Ctrl + K. (If you have not set a 

password, this choice is grayed out.) The following screen is displayed, hiding the data in your 
gradebook.

Unlocking a Gradebook

To unlock a gradebook:
1. Click Unlock. The Unlock Gradebook screen is displayed.

2. Type either the gradebook password or your network login password.

3. Click OK. The gradebook is unlocked and you can see the data.
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Locking and Unlocking Scores
After you have entered scores for a particular task, you can lock them so that they cannot be 
accidentally overwritten.

To lock and unlock scores:
1. From the Tasks menu, select Edit Task.

2. Select the Points tab.

3. Select a task.
Figure 3-11. Selecting a task

4. Select Scores Locked.

5. Click Close. You cannot change the scores for that particular task.

6. To unlock the scores, repeat steps 1–3 and then clear the Scores Locked checkbox.
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InteGrade Pro gradebook software provides a numeric and a skill spreadsheet for each class by 
default. An End Term spreadsheet is created when you import a class roster file from your 
administration system. You can also create an attendance spreadsheet.

You can define as many spreadsheets as you need for a particular class. Many users create separate 
numeric spreadsheets for each term or semester.

As you work, you can open more than one class viewer to switch quickly from one spreadsheet to 
another. 

Managing Spreadsheets
Use the Spreadsheets screen from the Setup menu to manage your spreadsheets

Figure 4-1. Spreadsheets dialog box

On the left side of this screen is the list of spreadsheets. The right side of the screen lists details of the 
selected spreadsheet.

The Name appears in reports and whenever you select a spreadsheet. You can rename a 
spreadsheet without affecting End Term export.

The Kind is selected when you create a spreadsheet and can not be changed later.
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Start Date and End Date define the date range the spreadsheet covers. For attendance 
spreadsheets, this affects which days you can enter attendance. For other spreadsheets, this 
affects whether the spreadsheet should be included in the Multi-Class Report

Grade Table specifies which grade table should be used to look up letter grades.

Calculation Method (which appears only when a numeric spreadsheet is selected) controls 
whether the spreadsheet should use total points or weighted type. This affects the way your 
overall spreadsheet grade is calculated, and should not be changed without careful 
consideration.

To create new spreadsheets:  
1. Select the class that you want to use the spreadsheet for.

2. From the Setup menu, select Spreadsheets. 

3. Click New. 

4. From the New Spreadsheet screen, select the type of spreadsheet you want to create. 

If you select an attendance spreadsheet and click Next, you must enter a spreadsheet name as 
well as a start and end date.

If you select numeric spreadsheet and click Next, you must enter a spreadsheet name.

5. Click Create.

6. Select the Notes tab and type a short description of this spreadsheet.

7. Click Close.

To rename spreadsheets:
1. Select the class that uses the spreadsheet you want to rename.

2. From the Setup menu, select Spreadsheets.

3. Select the spreadsheet to rename.

4. On the General tab, type a new name in the Name field.

5. Click Close.

To delete spreadsheets:
1. Select the class that uses the spreadsheet you want to delete.

2. From the Setup menu, select Spreadsheets. 

3. Select the spreadsheet. 

4. Click Delete.

5. Click Yes to confirm the deletion. When you delete a spreadsheet, all tasks, scores, spreadsheet 
notes for the students, and score notes are permanently lost.
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Changing the Look of a Spreadsheet
You can choose your preferred date format, the titles for the extra (user-defined) fields, and how you 
want your spreadsheets to display. The spell checking options are described in the section Checking 
Your Spelling.

To change the look of a spreadsheet:
1. From the Setup menu, select Display.

Figure 4-2. Display dialog box

2. Click the Date tab to make changes to the date settings. The InteGrade Pro software always 
stores the year within the program as a 4-digit number, but you can choose how you want to see 
the date displayed. The sample date in the lower right corner changes to reflect your settings.

Figure 4-3. Extra Field Titles tab
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3. Click the Extra Field Titles tab to change the titles for five extra student fields and five extra 
task fields. For example, you may want to name a student field Locker. You can change these 
titles at any time. To see these fields in use, from the Setup menu, select Students, then click 
Schools.

4. Click the Spreadsheet tab to customize your spreadsheets. 
Figure 4-4. Spreadsheet tab

You can change the visual appearance, including whether to display ledger lines and highlight 
the selected row and column. You can also select the colors of:

Rows as they display

The selected row or column 

Text you can edit

Text you cannot edit

Hot Linked text

Corner clips 

Changes affect all spreadsheets. The sample spreadsheet changes to reflect your choices. Click 
Reset Colors to revert to the default colors.

5. To see the shortened form of the task names, select Show Task Short Name.

6. To see inactive students, or the students’ last names first, make those selections.

7. You can decide if you want inactive students to appear at the top or bottom of sorts, or with other 
items, using Sort inactive students.

8. Decide how wide you want the columns to be. You can select from 7 to 14 characters wide. The 
wider the column, the more of the headings you see.

9. Click Close.
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Customizing Spreadsheet Columns
Depending on the spreadsheet and view you selected, you can customize the columns for students, 
tasks, and types. Changing the column names does not affect the data. If you want to see two of the 
same columns at once, open another class viewer. For example, you might want to see two different 
student demographics.

To customize spreadsheet columns:
1. Select the spreadsheet you want to customize.

2. From the View menu, select Change Columns.

On a numeric spreadsheet, with the view selected as task, you can customize six columns for 
student information and six for tasks.

Figure 4-5. Numeric Spreadsheet, Task view

However, if the view is selected as type, you can change any of five statistics on the Type tab, 
in addition to the six columns of student information as shown above.

Figure 4-6. Numeric Spreadsheet, Type view
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On a skill spreadsheet, you can customize one column for student information and six for 
tasks.

Figure 4-7. Skill Spreadsheet

On an End Term spreadsheet, you can customize one column for student information.
Figure 4-8. End Term Spreadsheet

On an attendance spreadsheet, you can customize one column for student information.
Figure 4-9. Attendance Spreadsheet
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3. Select or deselect the columns to view. If you deselect a column, it is no longer visible on the 
spreadsheet. 

4. Using the drop-down lists, select the information you want to see in that column.

5. Click Close. 

There is a shortcut to change columns, directly on the spreadsheet.

To use other ways to change columns:
1. On the spreadsheet, click the blank column heading cell to the left (Windows) or right 

(Macintosh) of either the Task or Student columns.
Figure 4-10. Task or Student columns

2. Select Change Columns from the drop-down list. 

3. Do one of the following:

On the Change Columns screen, make the appropriate changes and click Close.

OR

Click the column header of an auxiliary column and select the information you want displayed 
from the drop-down list. Remember that you must first use the Change Columns screen to 
select a column to display.

Hot Linking Numeric and Skill Spreadsheet Grades to End Term Spreadsheets
InteGrade Pro now enables you to create an automatic link between spreadsheet grade from a 
numeric or skill spreadsheet and a column on an End Term spreadsheet. Once you establish a hot 
link, each time the grades are recalculated on the numeric or skill spreadsheet, the data on the End 
Term spreadsheet is automatically updated. You can remove a hot link at any time or recreate one if 
it is broken inadvertently.

For more information on working with hot links, see Finishing Up the Reporting Period.
Copyright © 2005 Pearson School Systems InteGrade® Pro User’s Guide, rev. July 8, 2005

70



Working With Spreadsheets
Managing Student Data
InteGrade Pro gradebook software helps you manage the student data you work with each day. You 
can add students to classes, view or change the demographic information for students, or 
confidentially show their progress to parents or students themselves.

Adding Students
As a general rule, you should never add students to a gradebook that you have imported from an 
administration system. If you do, the next time you update your gradebook from the administration 
system, that student will no longer appear. However, if you have created a gradebook manually, and 
you are adding students, see “Adding Students” on page 71 for additional information.

To viewing or modifying student data:
1. From the Setup menu, select Students. 

2. From the drop-down list in the upper left corner, select the class whose students you want to see, 
or select All Students.

3. Select the student to view or modify. 

4. Select the tabs and view, enter or edit information. The only required field is the student’s name. 

5. Use the Personal tab for demographic information. 
Figure 4-11. Personal tab
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6. The Contacts tab is used for the address and phone numbers for this student. Besides the 
Primary contact, you can also create a Parent/Guardian, Emergency, Physician, Mailing Address, 
and Other Contact Type.

Figure 4-12. Contacts tab

If an e-mail address is available, you can select Send e-mail reports to this contact.

7. Use the School tab for school information like grade, homeroom, and counselor that you need to 
track for this student. 

You can use another screen to change the extra field titles to say something more meaningful. 
From the Setup menu, select Display, then click the Extra Field Titles tab and make your 
changes.

Figure 4-13. School tab
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8. The Schedule tab shows imported student class schedule information. The information 
displayed on this tab is imported from the school administration system and cannot be edited. If 
there is no schedule information available for a student, a message is displayed when you access 
the Schedule tab. The schedule information is based on scheduled class period, not rotating 
period.

Figure 4-14. Schedule tab

9. The Classes tab shows which classes a student is enrolled in. If there are no classes selected, it 
means the student is not enrolled in any of them.

Figure 4-15. Classes tab
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10. The Scores tab shows how the student is performing on tasks. You can select which spreadsheet 
to use from the Spreadsheet drop-down list at the top of the tab. If you have chosen to show all 
students, the Scores tab appears dimmed.

You can use this tab for data entry and for showing a single student’s scores. You can customize 
two of the right-most columns by clicking on the header cell and selecting a new heading.

Figure 4-16. Scores tab

11. The Stats tab shows how a student fared on a single task, using 12 different score 
transformations.

Select a spreadsheet and task to use from the drop-down lists at the top of the tab. If you choose 
to show all students, the Stats tab appears dimmed.

Figure 4-17. Stats tab
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12. The Notes tab records your comments about a student. You can keep separate notes for each 
spreadsheet.

If you choose to show all students, the Notes tab appears dimmed. A small marker in the lower-
right corner of the cell on the spreadsheet indicates that notes exist for that student.

Figure 4-18. Notes tab

13. Click Close.

To add student contacts:
1. On the Contacts tab of the Students screen, click New. A New Contact displays with a type of 

Other.
Figure 4-19. Contacts tab
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2. In the Contact Type drop-down list, select the type of contact this is.
The symbol beside the name changes, according to the type of contact you select.

3. Type the name, address, and phone numbers.

Deleting Students
You can delete students from a gradebooks, from a class, or you can inactivate them. Deleting from 
the gradebook removes all information about a student, including demographic data and scores. Use 
this option only if a student has permanently left your school and you do not need records for the 
student. 

To delete students:
1. From the Setup menu, select Students. 

2. Select the appropriate class from the drop-down list at the top of the screen, or select All 
Students.

3. Select the student to delete.

4. Click Delete.

5. On the screen that displays, choose to delete from the gradebook, remove from a class, or make 
the student inactive.

Figure 4-20. Delete student confirmation

6. Click Delete, Remove, or Inactivate. You do not have to confirm the action.
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Sorting Students
Sort orders that you select here are reflected in the reports.

7. From the View menu, select Sort Students. 
Figure 4-21. Sort Students dialog box

8. Decide how you want to sort the students:

Name

Demographic data such as birth date, first name, gender, or one of the 16 choices available 
from the by Demographic drop-down list

Task Score by selecting a task from the by Task Score drop-down list

Spreadsheet Grade

9. Choose the sort order, either ascending (A-Z) or descending (Z-A).

10. Click Sort.

11. Click Close.

To use other ways to sort students:
1. On the spreadsheet, click any column title in the Student area and select Sort Students. The 

Sort Students screen displays. Make your selections and click Sort.

On the spreadsheet, click any column title in the Student area and select Sort Students by 
Column. Student are sorted in the order of the scores in that column.

Click anywhere in the Student area of the spreadsheet and right-click (Windows) or Ctrl-click 
(Macintosh) and select Sort Students by Column or Sort Students from the context menu.

To scramble the order:
1. From the View menu, select Sort Students.

Use the Sort Students screen to arrange your students in random order. You could use this to 
post a report and you didn’t want student names listed in any particular order. 
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2. Click Scramble.

3. Click Close.

To sort manually:
From within the Sort Students screen, hold down the <Ctrl> key (< >in Macintosh) and drag a 
student name to a new position. 

Managing Class Data

Viewing or Modifying Class Data
1. From the Setup menu, select Classes. 

2. From the list at the left, select a class.

3. Use the General tab for information about this class. Use the drop-down lists to assign task type 
sets and spreadsheets to this class. Setting the Current Grade Spreadsheet is important when 
you are exporting grade information via InteGrade Pro Link.

Figure 4-22. General tab
.

.
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4. Use the Students tab to assign students to a class. Select a class, then a student, and click the 
right arrow.

Figure 4-23. Students tab

When you add students to the new class, the InteGrade Pro software looks for existing classes for 
that student. The system determines whether existing classes are similar to the new class. If a 
match is found, the system copies the task scores and notes information to the new class. The 
procedure is completed automatically each time you add a student to a class. If the system is 
unable to match information, nothing is copied, and you must add the student's scores and note 
information manually to the new class.

This auto copy feature copies numeric spreadsheet, skill spreadsheet, End Term spreadsheet, and 
attendance spreadsheet information.
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5. Use the Notes tab to record your notes about this specific class. It provides an ideal location for 
keeping your course syllabus.

Figure 4-24. Notes tab

6. Click Close.

To create classes:
1. From the Setup menu, select Classes.

2. Click New.

3. Click Next.

4. Type a name and click Next. This is the only required field.

5. Select a task type set from the drop-down list and click Next.

6. Register students by selecting their names from the list.

When you add students to the new class, the InteGrade Pro software looks for existing classes for 
that student. The system determines whether existing classes are similar to the new class. If a 
match is found, the system copies the task scores and notes information to the new class. The 
procedure is completed automatically each time you add a student to a class. If the system is 
unable to match information, nothing is copied, and you must add the student's scores and note 
information manually to the new class.

This auto copy feature copies numeric spreadsheet, skill spreadsheet, End Term spreadsheet, and 
attendance spreadsheet information.

7. Click Next.

8. Choose Weighted Type, Total Points, or Skill.

9. Click Create.
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To delete classes:
If you delete a class, all spreadsheets, tasks, scores, and notes associated with that class are also 
deleted.

1. From the Setup menu, select Classes.

2. Select a class.

3. Click Delete.

4. Click Yes to confirm the deletion.

Adding Students to Classes
There are two ways to add students to classes. The students must already be entered in a gradebook. 
You can use either the Classes or the Students screen.

To add students by using the Classes screen:
1. From the Setup menu, select Classes.

2. Click the Students tab.
Figure 4-25. Students tab

3. Select the student you want to add from the Students not enrolled in class column, then click 
the right-facing arrow. The Students enrolled in class column displays the student’s name.

4. Click Close.
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To add students by using the Students screen:
1. From the Setup menu, select Students.

2. Click the Classes tab.
Figure 4-26. Classes tab

3. Select the student you want to add to a class, then select the class or classes you want to add 
them to.

4. Click Close.

Removing Students From Classes
There are three ways of removing a student from a class. Removing a student from a class 
permanently removes all scores associated with that student.

To remove students from classes:
1. From the Setup menu, select Classes.

2. Click the Students tab.
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3. Do one of the following:

Select the student you want to remove from the Students enrolled in class column, then 
click the left-facing arrow. The Students not enrolled in class column displays the student’s 
name.

Or

From the Setup menu, select Students.

Click the Classes tab. 

Select the student to remove, then deselect the appropriate class.

Or

From the Setup menu, select Students.

Select the student to remove, then click Delete.

On the screen, select Remove From Class.

Click Remove.

Making a Student Inactive
You can view an inactive student’s grades up to the date they became inactive, even though grades 
are no longer being calculated.

Making a student inactive does not delete their scores or other information from the spreadsheet. 
Inactive students are identified by striking out their names on reports and spreadsheets like this: 
Robert Jones. In addition, in the main viewer area the student’s entire row will appear in a different 
color and his or her name will appear in parenthesis.

You can choose whether or not show inactive students via a control in the lower left corner of the main 
spreadsheet. You can change whether inactive students are sorted to the top or bottom via the 
Spreadsheet tab of Display in the Setup menu.

To make a student inactive:
1. From the Setup menu, select Classes.

2. Click the Students tab.

3. Click Student Status. A list of students currently enrolled in the selected class displays. All 
students with selected check boxes before their name are currently active.

4. Clear the check box before the name of the student you want to inactivate.

5. Click OK. 

6. Click Close.
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You add tasks and enter scores and notes daily. With the InteGrade Pro software, you can also adjust 
scores in several ways. All these functions are available from the Tasks menu.

Creating a New Task

To create a new task:
1. From the Tasks menu, select New Task.

2. Click Next.
Figure 5-1. New Task dialog box

3. Type the task name.

4. Enter the date assigned and the due date.

5. Select the type of task from the drop-down list.

6. Enter the Out of score.

7. If you choose, you can enter a scale factor and a maximum score (the same as the Out of score). If 
you do so, you are warned if you accidentally enter a score higher than the maximum. 

8. Click Create.
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Other Ways to Create Tasks
You can also create new tasks in the following ways:

Use the keyboard shortcut of Ctrl + N (Windows) or  N (Macintosh) 

Click the Task Name column heading and select New Task.

Click New from the Edit Tasks screen.

Select an existing task and click Copy from the Edit Tasks screen; The new task has the word 
“copy” at the end of its name.

Import the tasks. “Importing Tasks, Spreadsheets, or Classes” on page 46

Copy the tasks from another spreadsheet. “Copying Multiple Tasks” on page 89

Editing Tasks

To view or modify tasks:
1. From the main viewer, select the class whose tasks you want to modify.

2. From the Tasks menu, select Edit Tasks.
Figure 5-2. Edit Tasks dialog box

3. From the task list at the left, select a task to view or modify. 

4. On the General tab, if you want to change the name of this task, edit the Task Name text box.

5. Review the abbreviated name for this task that the system created. The spreadsheet uses this 
shorter name. If you want to change the name, click Custom and enter a new name.

6. Review and modify the date fields, if necessary.
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7. The selection Allow Export to InteGrade Link is on by default. This is used to extract specific 
task data for other programs.

NOTE: The Advanced fields are used only on the advice of your System Administrator.

8. On the Extra tab, you can record other details about this task. If you choose to use these fields, 
use the Display command from the Setup menu to customize these field names.

Figure 5-3. Extra tab
Copyright © 2005 Pearson School Systems InteGrade® Pro User’s Guide, rev. July 8, 2005

86



Entering Tasks, Scores, and Notes
9. The Points tab includes all the fields you saw when you created this task. You can modify any of 
these fields. If you do so, all grades are automatically recalculated. Select Scores Locked to 
prevent accidentally overwriting the scores.

Figure 5-4. Points tab

10. Use the Scores tab to view and modify the scores for this task. This is one of the screens where 
you can enter scores for new tasks. You can customize the right-most column by clicking the 
column header and selecting another score transformation from the drop-down list.

Figure 5-5. Scores tab
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11. Use the Stats tab to view 19 different statistical pieces of information about this task.
Figure 5-6. Stats tab

12. Use the Notes tab to record notes about this task.
Figure 5-7. Notes tab

13. Click Close.
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Deleting Tasks
Deleting a task removes all scores for that task from your gradebook.

To delete a task:
1. From the Tasks menu, select Edit Tasks.

2. Select the task to delete.

3. Click Delete. 

4. Click Yes to confirm the deletion.

The Edit Tasks screen is the starting point for many task-related activities. 

To use other ways to open the Edit Tasks screen:
Do one of the following:

From the Tasks menu, select Edit Tasks.

Double-click any task name on the spreadsheet.

Click the Task Name column heading and select Edit Tasks from the drop-down menu.

Copying One Task
To quickly copy one task within the same spreadsheet, on the Edit Task screen select a task and click 
Copy.

NOTE: This way of copying does not bring the scores to the new task.

Copying Multiple Tasks 
You can copy tasks from the same spreadsheet or from another spreadsheet. You can copy more than 
one task at a time.

Copying tasks is a fast way to create a new task that is similar to an existing one. Copy the task, then 
modify it. Remember to give it a new name.

This procedure is especially useful for copying more than one task between spreadsheets. This 
procedure brings all the scores with the task, if the student name matches.

To copy multiple tasks:
1. From the Tasks menu, select Copy Tasks.

2. Select a class and a spreadsheet to copy from.

3. Click Next.

4. Select the task to copy. Use the All or None buttons if they help speed up your selections.

5. To move tasks, select Delete original tasks after copying.
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6. Click Next.

7. To transform the score while you are copying it, select another from the list. Otherwise, leave 
Raw Score selected and click Next.

8. Click OK. The task is copied into your current spreadsheet and appears highlighted.

9. Double-click the new task and change its name.

10. Make other changes to this task, as required.

To replace a task with another:
1. Select the class and spreadsheet that contains the task you want to replace.

2. In the Student area of the viewer, click the column title of the task you want to replace.

3. From the menus, select Replace Task.

4. Select a class and a spreadsheet to copy from and click Next.

5. Select the item to copy and click Next.

6. To transform the score while you are copying it, select another score from the list. Otherwise, 
leave Raw Score selected and click Next.

7. Click OK. The task replaces the selected task in your current spreadsheet.

8. Edit the task as required.

Combining Tasks
The InteGrade Pro software can combine several tasks into a new task to help you manage a large 
number of tasks more efficiently. 

This feature does not work as described if one of the scores to be combined is an INC (Incomplete) 
score. The result of combining tasks when one of them has an INC score is a combined task with an 
INC total combined score.

As a precaution, print the Spreadsheet report before combining tasks, especially if you intend to 
delete the tasks after combining them. 

To combine tasks:
1. Select the class containing the tasks you want to combine.

2. From the Tasks menu, select Combine Tasks.

3. Choose whether you want to combine the tasks to total points (15 + 15 + 10 = 40) or whether you 
want to combine to a percentage (a new task out of 100) and click Next.

4. If you selected to combine to Total Points, use the Task Type list to select the type of tasks you 
wish to combine. If you selected to combine to a Percentage, select the Filter button to filter out 
certain types of tasks.

5. Select the tasks to combine. Use the All or None buttons to speed up your selection.

6. Type the name of the new combined task and select the amount of precision for the score. Click 
Next.
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7. Choose whether you want to delete the tasks being combined. Delete the original tasks only if you 
no longer need details about the individual tasks and if you have printed the Spreadsheet report 
for future reference. Click Next.

8. Click Combine. The combined task is displayed as a new task at the end of the list. It's Out Of 
value is either the value you specified or the total of all the tasks being combined, depending on 
which option you chose. It's scale factor is 0.0 to prevent it from affecting the class totals.

9. Edit the new task and change its scale factor to 1.0 to include it in the calculations.

NOTE: Instead of deleting the original tasks, consider changing their scale factor to 0.0. This 
prevents them from affecting the totals and keeps them in your spreadsheet should you 
decide that you want to use them later. You can also save the gradebook under another name 
to preserve your original tasks. When you are satisfied with the merged results, you can 
delete the original gradebook. If not, you can delete the copy.

Sorting Tasks
Sorting tasks lets you quickly see the results the way you want to see them.

To sort tasks:
1. From the View menu, select Sort Tasks.

Figure 5-8. Sort Tasks dialog box

2. Choose the field you want to sort on:

By Task Name is the default sort.

By Auxiliary lets you select any of 12 other fields from the drop-down list.

By Statistic lets you select from 19 different score transformations in the drop-down list.

3. Choose the direction of sort. Ascending (A-Z) is the default sort. Your other choice is 
Descending (Z-A).

4. Click Sort.
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To use other ways to sort tasks:
1. Do one of the following:

On the spreadsheet, click any column title in the Tasks area and select Sort Tasks. The Sort 
Tasks screen displays. Make your selections and click Sort.

On the spreadsheet, click any column title in the Tasks area and select Sort Tasks by 
Column. Tasks are sorted in the order of that column’s data. For example, if you want to see 
which task had the highest class average, you would sort on the Class Avg column.

Click anywhere in the Tasks area of the spreadsheet and right-click (Windows) or Ctrl-click 
(Macintosh) and select Sort Tasks by Column or Sort Tasks from the context menu.

To scramble the order:
1. From the View menu, select Sort Tasks.

2. Click Scramble.

3. Click Close.

To sort manually:
From the Sort Tasks screen, hold down the <Ctrl> key (Windows) or  key (Macintosh) and drag 
a student name to a new position. 

Bonus Tasks
There are three different ways to give bonuses:

Giving a student more than 100% on a task.

Adding points to a task type.

Adding to the overall spreadsheet grade.

Scores on bonus tasks can not be shown as letter grades. They will appear as n/a on reports.

Giving a student more than 100% on a task

Although each task has is out of a set number of points, you can exceed that out of to give a bonus. 
Exactly how many percentage points this contributes to the final grade depends on how many tasks 
you’ve set up (in the task type for Weighted Type, or the entire spreadsheet for Total Points) and task 
type weighting (on Weighted Type spreadsheets).

Adding points to a task type

To add points to a task type, create a task of that type, out of zero. Points assigned to this task will be 
added directly to the type’s total (on Weighted Type spreadsheets) or the total points for the 
spreadsheet (on Total Points spreadsheets). Exactly how many percentage points this contributes to 
the final grade depends on how many tasks you’ve set up (in the task type for Weighted Type, or the 
entire spreadsheet for Total Points) and task type weighting (on Weighted Type spreadsheets).
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For example: On a Weighted Type spreadsheet, the Quiz type contains two tasks: Quiz #1 (out of 10) 
and Quiz #2 (out of 10). This means the Quiz type is out of 20. Create a new Quiz task out of zero 
called Quiz Bonus. If George Jones received 8 on each Quiz, he has 16 out of 20 possible Quiz points 
(75%). If you give him a score of 2 on Quiz Bonus, he will instead have 18 out of 20 possible Quiz 
points (90%).

Adding to the overall spreadsheet grade

Lastly, you can add directly to the overall spreadsheet grade. With a Weighted Type spreadsheet, this 
means adding percentage points. On a Total Points spreadsheet, this means adding points. To do this, 
you need to create a task type called *bonus*. You must put an asterisk (*) before and after the word 
bonus. Enter a weight of zero for this task type.

To add this kind of bonus task, create a task of type *bonus* out of 0. Scores entered on this task will 
add directly to the overall grade.

Working with Scores
After your classes are set up and you have entered students and tasks, you need to enter scores for 
those tasks.

You can enter scores in either numeric or skill spreadsheets. You can also create hot links between 
numeric or skill spreadsheets and End Term spreadsheets. These hot links link the spreadsheet grade 
to the End Term spreadsheet. Any time the numeric or skill spreadsheet grade changes, the End 
Term spreadsheet is automatically updated.

InteGrade Pro gradebook software does not prevent you from entering scores above 100%. To remind 
you of such scores, a cell has a small marker in the upper-right corner if the score is over 100%. This 
is different from a marker in the lower-right corner of the cell, which indicates the presence of a note. 
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Using the Edit Tasks Screen
When you enter scores in the Edit Tasks screen, the student name is next to the score. Only one task 
is visible at a time. You can customize the third column at the right to display the student’s score in a 
number of ways.

To use the Edit Tasks screen:
1. Select the appropriate class and spreadsheet.

2. From the Tasks menu, select Edit Tasks.

3. Select a task.

4. Click the Scores tab.
Figure 5-9. Scores tab

5. Beside each student’s name, enter the scores for that task.

6. Click Close.
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Entering Scores on the Spreadsheet
Entering scores in the spreadsheet lets you move quickly between tasks and lets you see at a glance 
how the student fared on other tasks.

To enter scores on the spreadsheet:
1. Select the appropriate class and spreadsheet.

2. On the spreadsheet, in the Student area of the viewer, locate the column labeled with the short 
form of the task name.

3. Move the cursor to the correct row for the student whose score you are entering.
Figure 5-10. Entering scores on the spreadsheet

4. Type a numeric score or a special score. You can also right-click the cell (Windows) or Ctrl-Click 
(Macintosh) and select a special score from the context menu. Skill scores can include letters and 
numbers, up to seven characters long. These scores are not based on grade tables. Numeric scores 
that are above the maximum score defined for the task generate a confirmation screen. 

5. Press Enter or use either the Up or Down arrow keys to enter the score.
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To use the Students screen:
1. From the Setup menu, select Students.

2. Click the Scores tab.
Figure 5-11. Scores tab

3. Select the appropriate spreadsheet in the drop-down list.

4. Select a student.

5. Locate the task that requires the score and type the score.

6. Press Enter or use either the Up or Down arrow keys to enter the score.

7. Repeat Steps 4–6 for each student’s score.

8. Click Close.

Scores Automatically Copied to Spreadsheets
Transferring Students to a New Class  The InteGrade Pro software now includes a feature that assists 
you when you transfer a student from one class to another class (for example, transferring a student 
from one period of English 11 to another period of English 11). This type of transfer can happen in one 
of two ways: when students are imported from an updated roster file or when a student is added 
manually to a new class.

Each time a student is added to a class (whether by importing students or by manually adding a 
student), the InteGrade Pro software looks for existing classes for that student. The system 
determines whether any of the existing classes are similar to the new class. If a match is found, the 
system copies the task scores and notes information to the new class. The procedure is completed 
automatically each time you add a student to a class. If the system is unable to match information, no 
information is copied and you must add the student's scores and note information manually to the 
new class.

This auto copy feature copies numeric spreadsheet, skill spreadsheet, End Term spreadsheet, and 
attendance spreadsheet information.
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Rules Governing the Student Copy Process  When the InteGrade Pro software attempts to transfer 
student scores and notes from one class to another, it performs a series of checks to ensure that the 
class to which the student is being copied is the same as the one where the student originates. 

This is accomplished as follows:

The software looks for a class with the same course ID. If no matching class is found, nothing 
is copied.

If a matching course ID is found, the software checks whether any spreadsheets in the existing 
class match any spreadsheets in the new class. Spreadsheets match if they have the same 
spreadsheet ID, are of the same type and the names match. If no spreadsheet match is found, 
nothing is copied.

If a matching spreadsheet is found, the software checks whether any of the tasks on the 
spreadsheets match. To match tasks, the software checks task IDs, task names, types, “out of” 
scores and due and assignment dates.

After scores have been copied for a student, you should review them for accuracy. Using the new Fill 
Row feature, you can quickly replace a row of scores for a student (across all copied tasks) with 
another score. For example, if you want to delete the copied scores, you can replace the existing scores 
with a blank score.

NOTE: In the above steps, if the InteGrade Pro software encounters more than one matching course, 
spreadsheet or task, that course, spreadsheet or task is not copied.
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Entering Many Scores At Once
If you need to enter the same score for many students and tasks, use the Bulk Fill command from the 
Tasks menu. You can also use the Bulk Fill feature for entering missing scores, or replacing existing 
scores.

A related command is the Fill Column command, accessed by clicking a column title. This command is 
ideal for quickly entering the same score in the entire column. It is also useful for erasing a column by 
filling it with blanks.

To use the Bulk Fill feature:
1. From the Tasks menu, select Bulk Fill.

Figure 5-12. Bulk Fill dialog box

2. Select the students who are to receive this score. Use the All or None buttons to speed your 
selection.

3. Select the tasks that are to receive this score. Use the All or None buttons to speed your 
selection.

4. Type the new score.

5. Select Replace only Empty scores if you want this score going only to students who currently 
do not have a score for this task.

6. Click Fill.
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Bulk Fill Filters  You can create rules to determine which students and tasks should receive the score. 
Once you specify the rules, you can select specific students and tasks from the ones that were filtered.

To use the filter with bulk fill:
1. From the Tasks menu, select Bulk Fill.

2. On the Bulk Fill screen, click Filter.

3. Click the Filter button below the Students or Tasks area.

You can create and use a filter for students or for tasks, or for both students and tasks.
Figure 5-13. Filters for students and tasks

4. Select Show Students Whose or Show Tasks Whose.

5. Select the filter you want to use, and modify it using the drop-down lists.

For example, if you want to see only the students who were away with the flu, and if you had put 
the word “flu” in their student score note, select Student score note contains and type the 
word flu. Or if you want to see the tasks that are due on a certain date, select Due Date and use 
the drop-down lists to complete the expression.

6. Click OK.

7. Type the new score.
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8. Select Replace only Empty scores if you want this score going only to students who currently 
do not have a score for this task.

9. Click Fill.

To fill columns:
1. In the Student area of the viewer, click the column header of the column you want to fill.

2. From the menu that displays, select Fill Column.
Figure 5-14. Fill Column dialog box

3. Enter the score you want to use to fill the column.

4. To fill only the blank cells, select Replace only empty scores.

5. Click Fill.

Erasing Scores Using the Fill Row Command
The Fill Row screen is used to quickly erase all of the task scores for a particular student. It is 
normally used when a student has been added to a class and the scores copied by the system require 
editing or deletion. You can delete all of the task scores for a student by replacing the existing scores 
with a blank score. This in effect deletes the scores for the student across all tasks.

Filling a Row of Scores  This procedure is used to replace a row of existing scores for a student (across 
all tasks on the spreadsheet). You can use this to effectively erase all of the scores in a row or to 
replace them with another score. 

To fill a row of scores:
1. In the Class viewer, right click any task cell for the student whose scores you want to replace.

2. From the Right Click menu, select Fill Row.

3. On the Fill Row screen, enter the New Score. You may leave the New Score field blank if you 
wish to erase all of the scores for the student.

4. If you wish to replace only the empty scores, check the Replace only Empty scores checkbox.

5. Click Fill.
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Scanning in Scores (Windows)
The scanning feature of the InteGrade Pro software enables you to scan in scores from a standard 
Pearson School Systems scan form. This feature is not available on a Macintosh.

This procedure assumes that you have a functioning scanner attached to your computer and that you 
have all the appropriate scan forms ready. Scores are not actually created in your gradebook until the 
final step of this process. Scanning updates tasks in the current viewer.

Warning: Performing other tasks or starting additional applications while scanning can cause 
unpredictable results. Pearson School Systems recommends that you do not open other applications 
or attempt to perform other tasks while scanning.

To scan in scores:
1. From the Tasks menu, select Scan.

Figure 5-15. Scan dialog box

2. The name of your scanner displays. Click Diagnostics only if you need to test whether or not 
your scanner is working correctly. Use the Scanner Setup button which leads to the Scanner 
Configuration screen only on the instructions of your system administrator.

3. Click Next. 
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Figure 5-16. Scan tasks

4. Choose whether or not you want the scanned in scores to replace the scores of an existing task or 
create a new task.

If you choose Existing, you must also decide if you want to replace all scores or only empty 
scores.

If you choose New, you must enter a task name, select its type from the drop-down list, and 
enter a due date.

5. Click Next.

6. Confirm that the first form in the scanner is the test answer key and click Next.

7. Review the results of scanning the key sheet. If you are satisfied that you have the correct forms 
in the scanner, click Next.

Scanning begins and a progress bar displays on screen. The student name of the sheet being 
processed displays.

If a student ID is encountered twice, a screen displays asking you if you want to replace the 
data. Clicking Yes replaces the original scanned results for that student with the latest scan 
results. Clicking No retains the original scanned results and ignores this latest scan.

If an unknown student ID is encountered, a screen displays “No such student in class”. Click 
OK to resume the scanning process. The score for the unknown student ID is ignored.

8. When scanning is complete, review the results on screen. If you want to print this information, 
click Print Report.

9. Click Close to create a task and add the scanned results to your gradebook.
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How Grades Are Calculated
InteGrade Pro gradebook software always calculates the correct grade for a student. The following 
example show the methodology used to calculate that grade. 

First, assume that the circled Type Set is being used for Mathematics.

Figure 5-17. Grading Rules dialog box

Then, divide the points assigned to each type by the total points to calculate what percentage each 
type contributes to the student's grade. For example, Homework is worth 10 points out of 80, or 
12.5%.

But these figures hold true only if the student has at least one score for each task type. That means 
until the midterm exam is given, a student will have only completed tasks of the other three types. As 
a result, during that time each type will contribute more than the percentage just calculated.

Table 5-1. Total grade

Task Type Points Total Points Percent of Overall Grade

Homework 10 80 10 ÷ 80 = 12.5%

Exam 30 80 30 ÷ 80 = 37.5%

Quiz 20 80 20 ÷ 80 = 25.0%

Midterm Exam 20 80 20 ÷ 80 = 25.0%

Total 80 Total Grade = 100%
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In this case, with no midterm, the total points are only 60 instead of 80, and so homework contributes 
10 divided by 60 or 16.7% of the overall grade. 

Next, assume that the following nine tasks are given for the class:

Figure 5-18. Tasks for a class

Since only one midterm exam is given, it is worth the entire 25% of the overall grade as noted 
previously. Likewise, only one exam is given, so it's worth 37.5% of the student's grade. 

Quizzes are worth 25% of the overall grade, but there are more than one, so their contribution is 
calculated as follows. If we divide the points assigned to each quiz by the total points (53), we see 
what percentage each quiz contributes to the quiz portion of the total mark

.

Table 5-2. Percentage contribution

Quizzes Points Ttl. Quiz Points % of Quiz Grade % of Overall Grade

Right Triangles 15 53 15 ÷ 53 = 28.3% 28.3% of 25% = 7.1%

Trigonometric functions 20 53 20 ÷ 53 = 37.7% 37.7% of 25% = 9.4%

Sine and Cosine Laws 18 53 18 ÷ 53 = 34.0% 34.0% of 25% = 8.5%

Total 53 25%
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When the percentage of the overall grade that each task contributes is calculated, we arrive at the 
student's overall grade. The following table shows the three quizzes and their contribution to the 
overall mark, with the% of Overall Grade figures from the previous table, as well as the other tasks. 
This example also includes four Problems that are homework assignments contributing towards the 
16.7% of the total grade.

.

Table 5-3. Three quizzes and their contribution to the overall mark

Tasks Score Out Of % [score 
÷out of]

% of Overall 
Grade

Overall %
[% x% of Overall 
Grade]

Pythagorean Theorem Problems 8 10 80% 2.7% 2.2%

Right Triangles Quiz 12 15 80% 7.1% 5.7%

Trigonometric Functions (Sin, 
Cos, Tan) Problems

11 12 91.7% 3.2% 2.9%

Trigonometric Functions Quiz 17.5 20 87.5% 9.4% 8.2%

Inverse Trigonometric 
Functions (S~Cot) Problems

11 15 73.3% 4.0% 2.9%

The Cosine Law Problems 7.5 10 75% 2.7% 2%

Sine and Cosine Laws Quiz 15 18 83.3% 8.5% 7.1%

Trigonometry Midterm Exam 61 75 81.3% 25% 20.3%

Trigonometry and Statistics 
Final Exam

82 100 82% 37.5% 30.8%

82%
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For the final result, the InteGrade Pro software calculated 82% for the student's grade. The system 
recalculates these grades automatically whenever you change a score or a grade rule.

Figure 5-19. Final result
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Adjusting Scores
Usually, the scores achieved by your students are the ones used to calculate their overall grades. At 
times you might need to adjust the scores. For example, if a test was too hard and class scores were 
significantly lower than expected, you might want to adjust them. 

InteGrade Pro gradebook software offers several commands to help you adjust scores fairly. These 
commands are statistically sound and are easier to use than manually altering student scores.

The score-adjusting functions are available only while a numeric spreadsheet is active.

NOTE: Before altering any scores, you should print the Spreadsheet report. This gives you an 
archive of the original, unaltered scores. If the results are not what you expect, you can 
always “back out” of any changes if you have not saved the gradebook.

Dropping and Restoring Scores
The Drop/Restore Scores command automatically drops one or more scores that are the most 
damaging to a student’s overall grade. Because different task types like quizzes and homework may 
contribute differing amounts to the overall grade, the most damaging score might not necessarily be 
the lowest one. 

For example, suppose you have an equal number of quiz and homework tasks. A student receives 3 
out of 10 on a quiz and 4 out of 10 on a homework task. However, if quizzes account for 20% of the 
overall grade, while homework accounts for 40%, the 4 out of 10 homework task would be dropped, 
even though the quiz score of 3 out of 10 is lower. 

How It Works  The Drop/Restore Scores command tries dropping each score and then notes how it 
affects the student’s overall grade. This procedure applies Drop labels—a special type of Excused 
label—to the number of scores requested. 

The Drop label behaves like any other Excused label, except that its name is fixed and it does not 
appear in the Special Scores tab of the Grading Rules screen. 

The original score still exists beneath the Drop label. If you use another score manipulation factor, 
such as Curve Scores, you can affect the original score. 

Limitations of Drop Scores:

Drop Scores will not function for any student with an INC (Incomplete) score on ANY of the 
tasks included in your selection. You must replace the Incomplete score with an Excused label 
in order for Drop Scores to work.

The InteGrade Pro software counts Excused scores as dropped scores. If a student has the 
same or greater number of Excused labels as the number of scores you are asking to drop, the 
system will not apply additional Drop labels. For example, if a student has two Excused labels 
and you are requesting that the two most damaging scores be dropped, that student will have 
no additional scores dropped.
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Drops Scores does not work if you include a task that has all empty scores (i.e. a task that has 
not yet been completed). Be sure to select only tasks that have been scored. Do not select 
future tasks that have yet to be scored.

NOTE: If you type over a Drop label on the spreadsheet, you replace both the Drop label and the 
original score. You cannot restore the original scores if you do this.

To drop scores:
1. Select the class whose scores you want to drop.

2. From the Tasks menu, select Drop/Restore Scores.
Figure 5-20. Drop/Restore Scores dialog box

3. Select Drop Scores and click Next.

4. Enter the number of scores to drop. You can drop one or more scores.
Figure 5-21. Entering the number of scores to drop
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5. Select the students and tasks to include by manually choosing from the list. Use the All and 
None buttons to speed your selection, or click Filter and create rules.

6. Click Next.

7. Click Drop.

You can undo the Drop/Restore Scores manipulations at any time.

Using the Filter With Drop/Restore  You can create rules to determine which students and tasks should 
be selected to be dropped.

To use a filter with Drop/Restore:
1. On the Drop/Restore Scores screen, click the Filter button below the Students or Tasks area. You 

can create and use a filter for students or for tasks, or for both students and tasks.

2. Select Show Students Whose or Show Tasks Whose.

3. Select the filter you want to use, and modify it using the drop-down lists. 

For example, if you want to see only the students who were away with the flu, and if you had put 
the word “flu” in their student score note, select Student score note contains and type the 
word, flu.

Figure 5-22. Student filter
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4. If you want to see the tasks that are due on a certain date, select Due Date and use the drop-
down lists to complete the expression.

Figure 5-23. Tasks due on a certain date

5. Click OK.

Restoring Dropped Scores  You cannot manually remove a Drop label to reveal the original score. You 
must use the Drop/Restore Scores function to remove it. 

To restore dropped scores:
1. From the Tasks menu, select Drop/Restore Scores.

2. Select Restore.

3. Select the students and tasks to restore from the list, or click Filter and use rules.

4. Click Restore.

Curving Scores
The Curve Scores command alters scores for a task using one of two methods: 

Curve all scores to fall within a specified low/high range. 

Curve towards a specified mean and standard deviation.

Curving does not affect Excused scores or INC (Incomplete) scores. They remain INC until the 
student completes the assignment and the teacher records a score.

Curving can affect scores under a Drop label.
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To curve scores:
1. Select the class whose scores you want to curve.

2. From the Tasks menu, select Curve Scores.
Figure 5-24. Curve Scores dialog box

3. Select the method you want to use and click Next.

4. Select the task to curve and click Next.

5. Enter the parameters for the method you selected and click Next. 

If you selected High/Low, you must enter a new high and a new low score.

If you selected Mean/Standard Deviation, you must enter a new mean and standard deviation.

6. Indicate whether the curved task replaces the existing task or appears as a new task. Because 
curved scores cannot be “uncurved”, you should create a new task and then delete the original 
task later when you are satisfied with the results. 

7. Enter the name of the curved task and click Next.

8. Click Curve. The new curved task has a scale factor of 0.0. If you decide to keep the new curved 
task, change its scale factor to 1.0 to include it in the calculations.

NOTE: Instead of deleting the original task, consider changing its scale factor to 0.0 instead. This 
prevents it from affecting the totals and provides an additional safeguard should you decide 
to undo the curving later.
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Picking the Highest Scores
The Pick Highest Scores command creates a new task with the highest score out of a group of 
specified tasks. You can use this function when a student repeats a task and you allow the better of 
the two scores to stand.

The newly created task is always out of 100 and is of the task type that you specified. The system can 
select the highest score from any number of tasks. The tasks do not have to be of the same type, since 
they are compared by percentages.

To pick the highest scores:
1. Select the appropriate class.

2. From the Tasks menu, select Pick Highest Scores. Click Next.
Figure 5-25. Pick Highest Score dialog box

3. Select the tasks to include from the list, or click Filter and use rules. Click Next.
Copyright © 2005 Pearson School Systems InteGrade® Pro User’s Guide, rev. July 8, 2005

112



Entering Tasks, Scores, and Notes
4. Enter a name for the new task.
Figure 5-26. Entering a name for the new task

5. Choose a type for the new task and click Next.
Figure 5-27. New task type

6. Click Pick. The new task is added to the end of the list of tasks. The new task has a Scale Factor 
of 0.0. If you decide to keep the new task, change its Scale Factor to 1.0 on the Edit Tasks screen, 
to include it in the calculations.

NOTE: Instead of deleting the original tasks, consider changing their Scale Factor to 0.0 instead. 
This prevents the tasks from affecting the totals and it provides an additional safeguard 
should you decide to undo the Pick Highest Scores later.
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Working With Notes
You can enter notes directly in the spreadsheet in the Notes area, or on the Notes tab in the Student 
or Tasks setup screens.

Cells with notes have a small marker at the lower-right corner of the cell. You can see this in the 
sample gradebook. This is different from a small marker in the upper-right corner of a cell, which 
indicates that the score entered is over 100%.

Notes Area
The Notes area at the bottom of the screen is ideal for teachers who use notes frequently, or who 
comment extensively on skills.

Once the Notes area is visible, you can resize it by dragging the thin blue bar at the top of the Notes 
area. This helps you accommodate long and short notes, while conserving screen space.

The Notes area can record and display notes about tasks, students, and student scores on a task. For 
notes about the class or spreadsheet you must use the Classes or Spreadsheets screens (accessed 
under the Setup menu).

To view notes:
1. From the Show drop-down menu of the viewer, select one of the views that displays notes:

Students/Notes

Tasks/Notes

Tasks/Students/Notes

Seating Chart/Notes

2. Select the cell containing the note to view. The Notes area displays at the bottom of the screen.

NOTE: You can also view notes by selecting Show Notes from the View menu.

Figure 5-28. Notes area at the bottom of the screen
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To enter notes in the Notes area:
1. Select the cell where you want to enter the note. The title bar in the Notes area shows you which 

cell is being edited.

2. Type the note in the Notes area. Remember that notes are specific to the spreadsheet being 
viewed.

To enter notes for students or classes:
1. From the Setup menu, select Students or Classes.

2. Select the Notes tab.
Figure 5-29. Notes tab
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3. The Notes tab records your comments. You can keep separate notes for each spreadsheet. If you 
have chosen to show all students, the Notes tab appears dimmed. A small red marker in the 
lower-right corner of the cell on the spreadsheet indicates that notes exist for that student or 
class.

Figure 5-30. Notes that exist for that student or class

Finding Text in Spreadsheets and Notes
The Find command searches for a word or phrase in the spreadsheet and the notes behind it for tasks, 
students, and classes. It searches the current spreadsheet, and if the text is not found, you can choose 
to search other spreadsheets.

To find text in spreadsheets and notes:
1. From the Edit menu, select Find.

2. Type the characters you want to find.

3. To search only for complete words, select Whole Words Only. In that case, a search for “bat” 
would skip over “batch”.

4. To search the notes, select Search Notes.

5. To search the surface of the spreadsheet, select Search Spreadsheet Cells.

6. Click Find.

When the text is found, it is highlighted. To search other spreadsheets in this gradebook, select 
that spreadsheet in the viewer.

7. To repeat your search, use the Find Again command.
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Shortcut  Both the Find and the Find Again commands are available on the context menu that 
displays when you right-click (Windows) or Ctrl-click (Macintosh) a word in a note.

Checking Your Spelling
The InteGrade Pro software can check your spelling as you are typing a note for tasks, students, or 
classes.

Configuring the Spell Checker  You can customize the spell checker of InteGrade Pro gradebook 
software.

To configure the spell checker:
1. From the Setup menu, select Display and click the Spelling tab.

2. Select your spelling options:

Always check spelling controls when your spelling is checked. If it is checked, the spell 
checker is always on. If it is not checked, you have to choose Next Spelling Error from the 
Edit menu to activate spell checking.

Ignore words in all caps makes the spell checker skip words, like SAT, that are in capital 
letters.

Ignore words containing numbers makes the spell checker skip words, like 4th, that 
contain numbers.

3. Review the list of ignored words. You add words to this list during spell checking when you select 
Ignore Word from the context menu. 

Select a word and click Remove to remove it from the list, or click Remove All to clear the list.

4. Select how many suggestions you want to see in the context menu by sliding the control between 
Fewer Suggestions and More Suggestions.

Setting the slider to the far right offers many suggestions, some of which may be inappropriate. 
Setting the slider to the far left offers fewer suggestions, but is less likely to provide the correct 
suggestion for some words. Set the slider somewhere in the middle at first. You can change it 
later.

5. Select the dictionary you want to use from the drop-down list. 

6. Click Close.
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Correcting Misspelled Words  If you have set up Always Check Spelling, as you type, the misspelled 
word in your note displays underlined.

To correct misspelled words:
1. Display the context menu. Right-click in Windows, or Control-click on a Macintosh to display that 

context menu.

2. The context menu displays a list of suggestions. 

Select one of the words to replace the misspelled word.

If you know the word is spelled correctly, select Ignore Word.

If you choose to keep the spelling of this word, select Add to Dictionary.

Starting the Spell Checker  If you have not configured the spell checker to always check spelling, you 
can still start this process in one of two ways.

To start the spell checker:
Do one of the following:

From the Edit menu, select Next Spelling Error.

OR

Click a correctly spelled word to bring up the context menu (right-click in Windows or 
Control-click on a Macintosh) and select Next Spelling Error.

This command searches for the next incorrectly spelled word in this note and moves on to subsequent 
notes.

Using a Dictionary or Thesaurus  If your computer has Internet access you can use a public access 
dictionary and thesaurus.

To use the public access dictionary and thesaurus:
From the Notes right-click menu, select Dictionary.com to open a public access dictionary and 
thesaurus.
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The InteGrade Pro software provides a number of reports and graphs you can use to analyze the 
performance of your students and review the effectiveness of your tasks.

You can also e-mail a progress report to parents.

Working With Reports
This is an overview of creating a report. Details of each report display on the following pages.

To create a report:
1. Select one of these reports from the Reports menu. 

E-mail Student Progress Report

Class Attendance

Class Roster

Missing Tasks

Multi-Class

Seating Chart

Spreadsheet

Student Attendance

Student Demographics

Student Progress

Student Rank

Task Details

2. Select the specific content you want to see on the report.

3. Click Next.

4. Click Print.
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Selecting Students and Tasks
Here are some other ways to select and deselect students and tasks.

To select and deselect students and tasks:
Do one of the following:

To select all or nearly all the students or tasks, click All, then deselect the ones you 
don’t want included.

To select only a few students or tasks, click None to clear the list, then select the items 
as necessary.

To select using the keyboard, use the Up and Down arrow keys to move the cursor, 
and the space bar to toggle the selection of an item. (Not available on Macintosh 
systems.)

To select students based on certain criteria, click Filter.

NOTE: The task information displayed on the report depends on the auxiliary fields displayed. For 
example, if you select Due Date in the main viewer, that information shows in the 
Spreadsheet and other reports that display task information. If you select Skill Type for that 
column, that information displays. See “Customizing Spreadsheet Columns” on page 68.

Using Filters  Filters offer a powerful method of automatically selecting students or tasks based on 
criteria that you specify. These examples show how filters can help you:

Many schools require teachers to send interim reports home for students “at risk of failing.” 
The filters can help you precisely target such students. Conversely, the filters can help you 
identify those students who are doing well for additional praise.

If you have made note of the teams and clubs in which your students participate, you can use 
the filters to locate the band members who were on tour for two weeks. You can also print a list 
of the tasks they missed.

You can manually exclude students or tasks in the list returned by the filters. However, if you reapply 
the filter, the manually excluded lines are included again.
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To manually exclude students or tasks:
1. In the Students or Tasks area, click Filter. You can create and use a filter for students or for 

tasks, or for both students and tasks.

2. Select Show Students Whose or Show Tasks Whose.

3. Select the filter you want to use, and modify it using the drop-down lists. 

For example, if you want to see only the students who were away with the flu, and if you had put 
the word “flu” in their student score note, select Student score note contains and type the 
word flu.

Or if you want to see the tasks that are due on a certain date, select Due Date and use the drop-
down lists to complete the expression.

4. Click OK.

NOTE: Filters are stored during a session. For example, if you use the Student Filter in the Class 
Roster report, the filtered students display in the other reports as well. To not use a filter 
that you have created in a session, click Filter and select Show All Students.

E-mail Progress Report
You can now e-mail a progress report to parents or guardians. Before you can e-mail the reports, be 
sure that your e-mail connection is set up, and that you have an e-mail address entered in the Student 
screen for each recipient of this report.

NOTE: For Macintosh users, the e-mail Progress Report is only available on Macintosh Power PC 
models, running System 9.0 or later.
Copyright © 2005 Pearson School Systems InteGrade® Pro User’s Guide, rev. July 8, 2005

121



Creating Reports and Graphs
Setting Up E-mail Communications  If you electronically imported your data, some of this data may 
already be entered. 

To set up e-mail:
1. From the Setup menu, select Communication.

Figure 6-1. Communication dialog box

2. On the General tab, if you did not import your data, you may need to complete the Teacher 
Name and Teacher e-mail fields.

3. Enter the teacher and school Web sites where applicable.
Copyright © 2005 Pearson School Systems InteGrade® Pro User’s Guide, rev. July 8, 2005

122



Creating Reports and Graphs
4. Click on the e-mail tab. There are two different screens that can be displayed depending on the 
current setting in the Server Type field. Samples of the two screens follow.

Figure 6-2. First example of Email tab

Figure 6-3. Second example of Email tab

5. Speak to your school network administrator to find out if you should select MAPI or SMTP as the 
Server Type.

If the Server Type is SMTP, you will need the school’s E-mail Server and authentication 
information. This information is available from your system administrator.
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6. Enter your e-mail account name (such as, jdoe) in the Account Name field.

7. Click Close.

Entering Recipients’ E-mail Addresses  8.From the Setup menu, select Students.

1. Click the Contacts tab.

2. Select a student.

3. From the Contact Type drop-down list, select the contact for this student who will receive this 
report.

4. Enter their e-mail address.
Figure 6-4. Entering e-mail address

5. Select Send e-mail reports to this contact.
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Creating the E-mail Progress Report  For each student, you can prepare and e-mail a report detailing 
their tasks and scores received.

Reports are sent only to those contacts with e-mail addresses. Select the dates this report covers, as 
well as the tasks. You can choose to include an attendance summary, the class average, and any of 
your notes.

You can also choose to blind carbon copy (BCC) all emailed reports to your email address with the 
BCC: Teacher option. This will generate a lot of email in your in box, but it will give you an exact 
record of what went out, when and to whom.

If Include HTML Report is on, an HTML version of the report will be attached to the email. Some 
email servers consider HTML emails as spam, so these emails are rejected or delivered without the 
HTML attachment. InteGrade Pro always includes the text version of the report.

After selecting report options, click Next to go to the Preview screen. On the Preview screen, use the 
scroll bar across the top to see each individual report. The student name is displayed in the header of 
the preview screen and also within the report itself. The possible contacts for each student are 
displayed at the left. If an e-mail address displays in angle brackets <like this> beside the contact, 
and the contact has been selected, the report is sent. If no e-mail address displays, or the recipient has 
not been selected, the report is not sent. You can resize the window at the left which lists the contacts.
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Figure 6-5. Sample E-mail Progress Report

Class Attendance
This report displays a class list with the totals of various absences and late activity for the specified 
dates. This summary uses the system codes as defined in “Setting Up Attendance Codes” on page 51

Figure 6-6. Class Attendance dialog box

Enter the start and end dates that this report covers, and decide whether or not you want a summary 
and a legend. If you select Attendance Register, you get the detail of each day or a total of Late and 
Excused.
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Class Roster
This report creates a class list with blanks beside each student name. You can use this form to record 
everything from attendance and task scores to locker assignments and lunch money.

Figure 6-7. Class Roster dialog box

Select how you want your class roster to look. You can choose a large fill-in blank beside each student 
name, or select vertical lines with or without title spaces, depending on what you want to record. The 
Tall Rows option leaves you plenty of room to write on the roster.

Missing Tasks
This report identifies those tasks in which a student received a 0.0, Excused, or an Incomplete score.

Figure 6-8. Missing Tasks dialog box

Decide whether you want this report printed with one student per page, possibly with a line for a 
parent’s signature, or if you want a report listing all the students on one page. You can also select 
what kind of scores to include in the report.
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Empty scores on bonus tasks are not considered “missing” for this report, even if Empty Scores is on. 
The reasoning behind this is that for most tasks, empty scores are considered to be not entered yet. 
For bonus tasks, they are instead considered no bonus. The other options behave identically for bonus 
tasks as with other tasks.

NOTE: The options for this report are different if you are using a skill spreadsheet.

Multi-Class
This report creates a list of all scores by spreadsheet (numeric and skill) for each student for all 
classes. This report shows how well each student is doing in each class.

Figure 6-9. Multi-Class dialog box

To run the report:
1. Select the students and classes you want included in the report, as well as the date range and 

notes.

2. If you want to limit which spreadsheets this report prints, turn on Limit By Dates and enter a 
date range. This date range is used in conjunction with spreadsheet date ranges to determine 
which spreadsheets should be included. You can assign spreadsheet date ranges using 
Spreadsheets in the Setup menu.

3. Click Next to run the report.

The report displays detailed information for all selected classes and students. It also includes any 
additional information you selected on the report selection criteria screen (above).
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Seating Chart

To use the seating chart:
1. Select a class.

2. From the Reports menu, select Seating Chart. The seating chart for that class displays.

NOTE: If you are using the Windows version of the InteGrade Pro software, you must preview the 
seating chart at a magnification of 100% (full size). If you view the chart at any other size, 
the student pictures are displayed as black boxes.

Spreadsheet
This report displays the contents of the active spreadsheet. It serves multiple purposes depending on 
which spreadsheet is active.

If a numeric or skill spreadsheet is active, the Spreadsheet report shows how the students are 
doing on the tasks.

If an attendance spreadsheet is active, the Spreadsheet report shows the attendance activity 
over a specific date range.

If the End Term spreadsheet is active, the Spreadsheet report prints the contents of the End 
Term spreadsheet

Figure 6-10. Spreadsheet dialog box
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Student Attendance
This report displays a class list with the totals of various absences and late activity for the specified 
dates. This summary uses the system codes as defined in the section “Setting Up Attendance Codes” 
on page 51

Figure 6-11. Student Attendance dialog box

Enter the start and end dates that this report covers, and decide whether you want a summary and 
places for signatures.

Student Demographics
This report displays demographic information for students. Use it to verify the accuracy of the 
information entered and to print a permanent record of student information.

Figure 6-12. Student Demographics dialog box
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You can choose between two layouts: single line or multiple lines. Use single line if you are printing 
only a few demographic fields. Use multiple lines if you are printing many fields.

NOTE: If you are using the Windows version of the InteGrade Pro software, you must preview the 
student demographics report at a magnification of 100% (full size). If you view the report at 
any other size, the student pictures are displayed as black boxes.

Student Progress
This report shows the student’s score and class average for each task. It also shows missing tasks and 
a grades analysis graph. You can use it as an interim or informal report card.

Figure 6-13. Student Progress dialog box

Select the students and the tasks that you want included, along with the date range and other details.

Empty scores on bonus tasks are not considered “missing” for this report, even if Empty Scores is on. 
The reasoning behind this is that for most tasks, empty scores are considered to be not entered yet. 
For bonus tasks, they are instead considered no bonus. The other options behave identically for bonus 
tasks as with other tasks.
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Student Rank
This report ranks each student by how well they did on a particular task.

Figure 6-14. Student Rank dialog box

Select which students and which tasks you want included, and what kind of marks to include.

Task Details
This report prints the information recorded in the Edit Tasks screen. Use it to verify that the tasks 
you entered are correct.

Figure 6-15. Task Details dialog box

Select the tasks to include and choose how much detail to show.
Copyright © 2005 Pearson School Systems InteGrade® Pro User’s Guide, rev. July 8, 2005

132



Creating Reports and Graphs
Working With Graphs
This is an overview of creating graphs. Details of each graph display on the following pages.

To create graphs:
1. Select one of the following graphs from the Graphs menu. You can also use the shortcuts on the 

toolbar.

Student Performance

Task Comparison

Task Correlation

2. Select the specific content and style you want to see.

3. Click Print.
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Student Performance
This graph analyzes a student’s performance on each task, using one of six different Graph Styles: 

Earned Percent

Ink Blot

Score Bar

Whisker

Line

Whisker & Blot

Click the button at the far right, under the Help button, to change the orientation of this report.

Figure 6-16. Student performance graph

Select a Student. Optionally, select an Envelope of standard deviation, and the class average. 

Click the colored blocks next to Score and Average to change the display color.
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Task Comparison
This graph compares two tasks and displays the number of students with letter grades and 
percentage intervals for each task. It lets you view the relative difficulty of one task as compared to 
another and the approximate score distribution.

Select a graph styles from:

Area

Area 3D

Covered bar

Covered bar 3D

Line, Line 3D

Side Bar

Side Bar 3D

Figure 6-17. Task Comparison graph

Choose two tasks and the interval. Interval refers to the number of intervals on the X-axis. For 
example, an interval of 10 means the score ranges will be 0%, 10%, 20%, and so on.

Click the colored blocks next to Task 1 and Task 2 to change the display color.
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Click the first button at the far right, under the Help button, to change the ordering of the report 
(Task 1 followed by Task 2 instead of Task 2 followed by Task 1). 

Check the second button at the far right to change the report orientation.

Task Correlation
This graph compares any two tasks and shows the correlation of scores between the two. A high 
correlation means the class as a whole fared similarly on the two tasks.

Figure 6-18. Task Correlation graph

Select the two tasks from the drop-down lists.

Click the colored block next to Ink Blot to change the color of the graph
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Setting Up Reports and Graphs
Any change you make to one report applies to all reports printed after that, until you change these 
settings again.

To change a report:
1. From the Reports menu, select Report Setup. You can also click Setup on any report or graph 

screen.
Figure 6-19. Report Setup dialog box

2. In the Report Title field, type a report title. This title prints on all reports, so be sure the title is 
appropriate for any report and all classes.

3. In the Margins fields, the default report margin is 0.5 inches, but you can change it. For 
example, if you need to three-hole punch the reports, set the left margin to 1 inch.

4. In the Identify Students By field, the default is to identify by student name and the 
demographic field currently showing in the spreadsheet.

If you want to publicly post a report, you can suppress the student name and use a “scramble” 
sort on the spreadsheet to ensure greater confidentiality. You can also choose to print a 
demographic field that is not currently showing, or completely suppress the printing of additional 
demographics.

In the Font and Size field, you can change the way the report prints. The Windows version 
defaults to Arial 9 point; the Macintosh defaults to Geneva 9 point. If you change the font or size, 
it becomes the new default and applies to all reports.

Caution—Be careful when choosing a larger font size. You could be changing the layout of the 
report if text that is made larger spills over into a second line. Check the report preview carefully. 

If you move a gradebook to or from a Windows or Macintosh system, check the Font and Size settings 
before printing because the default font and size may not be what you expect.
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Previewing Reports 
All the reports automatically preview on-screen before they print. This enables you to check the 
effects of the parameters or the setup before printing. 

To preview a report:
1. Click Next on a report request screen to display the preview.

2. Click Print to continue with printing or click Cancel to close the window.

3. To adjust the parameters, click Setup. This returns you to the report request screen, without 
closing the preview.

4. After changing some settings, click Next to see how the new parameters affect the preview. 

Using the preview is slightly different, depending on the platform.

Windows Version
In Windows, the preview initially shows the entire page.

To work with the preview in Windows:
1. Click anywhere within the page to magnify the preview.

2. Click again to return to the full page view. You can also click the right mouse button and select 
either Zoom In or Zoom Out.

3. To print a single page of the report, click the right mouse button and select Print this Page.

A horizontal scroll bar displays above the preview area if there are multiple pages in the report. 
Use this bar to page through the report. You can also click the right mouse button and select Next 
Page or Previous Page.

4. To see the portions of the report that are out of view, use the scroll bars, or hold down the <Ctrl> 
key and drag the mouse.

NOTE: If you are using the Windows version of the InteGrade Pro software, you must preview the 
student demographics report and the seating chart at a magnification of 100% (full size). If 
you view these reports at any other size, the student pictures are displayed as black boxes.
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Macintosh Version
In the Macintosh version, the preview shows the entire page. Click anywhere within the page to 
magnify the preview. Use the horizontal and vertical scroll bars to move the view.

A horizontal scroll bar displays above the preview area if there are multiple pages in the report. Use 
this bar to page through the report, or use Command-N to page forward or Command-B to page 
backwards. You can also use the following mouse shortcuts:

Click and hold the mouse button to display a pop-up menu. 

To move through multiple pages, click and hold the mouse button and select Next Page or 
Previous Page.

To print a single page of the report, click and hold the mouse button and select Print This 
Page.

Previewing Graphs
All the graphs automatically preview on-screen before they print. This enables you to check the 
effects of the setup before printing.

After you have made any changes, click Print to continue with printing or click Cancel to close the 
window. 

Using the preview is slightly different, depending on the platform.

Windows Version
In the Windows version, the preview shows the page in a reduced size.

To enlarge the size of the viewing area, click the right mouse button to display a pop-up menu 
and select Zoom In. To return to the original size, click the right mouse button and select 
Zoom Out.

To move through multiple pages, click the right mouse button and select Next Page or 
Previous Page.

To print a single page of the graph, click the right mouse button and select Print This Page.

If an item on the pop-up menu appears dimmed, it is not available in this preview. To see the portions 
of the graph that are out of view, use the scroll bars, or hold down the left mouse button and drag the 
mouse.
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Macintosh Version
In the Macintosh version, the preview shows the page in a reduced size. Click the mouse button to 
magnify the preview. You can also click Preview to zoom in or out. To return to the original size, 
click the mouse button and select Zoom Out.

If an item on the pop-up menu appears dimmed, it is not available in this preview. To see the portions 
of the graph that are out of view, use the scroll bars, or hold down the mouse button and drag the 
mouse.
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7 Working With Attendance and Seating
Charts

The InteGrade Pro software can help you track attendance in two ways—with the Attendance 
spreadsheet and with the feature on the seating chart that lets you take attendance. 

About the Attendance Spreadsheet
In an attendance spreadsheet, calendar days replace the task columns. Attendance spreadsheets can 
be automatically created by import from your office administration system. They may also be created 
manually. 

If you manually created the attendance spreadsheet, you can switch the calendar days on or off. For 
example, you can turn on attendance days and turn off weekends and holidays. The columns for 
inactive days are gray. Calendar days on attendance spreadsheets created by import from your office 
administration system cannot be turned on or off.

Figure 7-1. Calendar days
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Determining Your Attendance Spreadsheets Needs
Consider the following when creating an attendance spreadsheet:

Do you frequently refer to attendance records? If you use a single spreadsheet, it can require 
extensive scrolling.

How do you organize your other spreadsheets—by semester or reporting period? You can 
organize your attendance the same way.

When do you take attendance? If it is twice a day, you should create at least two spreadsheets, 
because each spreadsheet records one attendance activity per student, per day.

To create attendance spreadsheets:
1. From the Setup menu, select Spreadsheet. 

2. Click New.

3. Select Create an Attendance Spreadsheet and click Next.

4. Enter a name for your spreadsheet and enter a start and end date.

5. Click Create.

6. Click Close. Your new spreadsheet is available from the Spreadsheet drop-down list on the class 
viewer.
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To enter attendance:
1. Select the appropriate attendance spreadsheet from the class drop-down list.

2. Ensure that the current school day is active. If you have a manually created spreadsheet, look for 
the check box in the column heading.

3. If a student is present, no action is necessary.

Figure 7-2. Entering attendance:

4. If a student is late or absent, enter the appropriate attendance code for students, either by typing 
the code or by using the drop-down list. Right-click the cell (Windows) or Ctrl-Click (Macintosh) 
and select the code from the context menu.

5. Optionally, open the Notes area and enter comments about the attendance activity.

To print attendance spreadsheets:
1. Select the appropriate attendance spreadsheet from the drop-down list.

2. From the File menu, select Print. 

3. From the Print screen, select Spreadsheet Report.

4. Click OK.

5. From the Spreadsheet Report screen, make any necessary changes then click Next.

6. Click Print.

You can also access the Spreadsheet Report from the Reports menu.
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About Seating Charts
The seating chart shows you where each student should be sitting. You can also choose to display 
student pictures, zoom in and out, display names and other information about your students, and 
move students between desks using a drag-and-drop operation. 

You can use the seating chart with any class in the gradebook, and you can select any spreadsheet in 
a selected class. If you display a numeric, skill, or End Term spreadsheet, the desk icons display task 
scores. If you display an attendance spreadsheet, the desk icons display attendance codes for the 
selected date and student.

NOTE: Removing a student from the seating chart does not affect the student’s enrollment in the 
class.

Creating a Seating Chart
There are two ways to create a seating chart. You can use the seating chart wizard that displays the 
first time you select Seating Chart from the Show drop-down list. You can also select the New Seating 
Chart option from the View menu. 

To create a seating chart for the first time
1. From the Show drop-down list, select Seating Chart.

2. Enter the necessary information in each of the screens. 

3. Click Create in the last screen to create your seating chart. The seating chart is in Layout Mode 
at the end of this process.

To create a seating chart as a replacement:
1. From the Show drop-down list in the viewer, select Seating Chart.

2. From the View menu, select New Seating Chart.

3. Because only one seating chart can be created per class, a warning message displays asking if you 
want to delete the current seating chart.

4. Click Yes to continue with the process and replace the current seating chart.

Figure 7-3. New Seating Chart dialog box
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5. Enter the number of rows, and the number of desks in each row, then click Next.
Figure 7-4. Grid spacing

6. To align the desks neatly on screen, select Snap to Grid. If you must change the default settings, 
do so, then click Next.

Figure 7-5. Assign Students to Desks

7. If you want the system to assign your students a spot in the seating chart, select Assign 
Students to Desks, then choose a method, either the order they appear in the gradebook, or 
random order. To assign students to desks yourself, deselect Assign Students to Desks. 

8. Click Create. The seating chart is in Layout Mode at the end of this process.

The Two Modes of Working With a Seating Chart  There are two modes for seating charts: Layout and 
Update. Layout mode is used to define the physical layout of the seating chart or assign students to 
desks. 

You are in Layout mode when the Layout Tool floating window is available and grid lines display on 
the seating chart. Update Mode is used to edit student scores and attendance in the seating chart.

You can switch between the modes by choosing Show/Hide Layout Tools from the View menu.
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Using the Layout Tool  Use the Layout Tool to edit the layout and desk assignments in the seating 
chart.

To use the layout tool:
1. From the View menu, select Show Layout Tools.

Figure 7-6. Layout Tools

The Layout Tool screen displays with a list of students in the selected class. The names of 
students with assigned desks display beside a desk icon. Students who are displayed as standing 
do not have an assigned desk.

2. To place an unassigned student into a desk, drag the standing student icon and drop it onto the 
grid. The student’s name and picture—if used—display on a new desk icon.

3. To add empty desks or a teacher desk to your seating chart, drag the empty desk or teacher desk 
icon onto the grid. The teacher desk includes a field for the teacher name. Editing this field does 
not change the teacher name stored in the gradebook.

4. To switch two students, drag one picture or desk over another.

5. To remove a student from the seating chart, highlight the desk and click Delete, or right-click 
the desk and select Remove Student From Desk or Remove Desk.

6. To hide the layout tools, from the View menu, select Hide Layout Tools.

Show/Hide Student Pictures  You can choose to show student pictures in the seating chart. These 
pictures are imported from CD-ROMs prepared for the school by a photography studio. (Macintosh 
computers require Apple QuickTime version 3.0 or later.)

To work with student pictures:
1. From the View menu, select Show Student Pictures.

2. To hide pictures, from the View menu, select Hide Student Pictures.

NOTE: If you are using the Windows version of the InteGrade Pro software, you must preview the 
seating chart at a magnification of 100% (full size). If you view the chart at any other size, 
the student pictures are displayed as black boxes.
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To zoom in an out:
1. From the View menu select Zoom to 150% or Zoom to 200%. 

2. Select Zoom to 100% to return to the default setting.

You can also use the magnifying glass icons on the horizontal scroll bar beneath the Seating 
Chart.

NOTE: This only works when in Update Mode (Layout tools are off).

Resetting Grid Options  You can change the spacing between pictures.

To reset grid options:
1. From the View menu, select Grid Options.

2. Select the spacing you want between pictures.

3. Optionally, choose to snap to the underlying grid.

4. Click OK.

NOTE: This only works when in Layout Tool Mode (Layout tools are on).

To take attendance from a seating chart:
1. You must be in Update mode to take attendance from a seating chart. Check the View menu, and 

if necessary, select Hide Layout Tools.

2. Select an attendance spreadsheet.

3. If a student is present, no action is necessary. If a student is late or absent, enter the appropriate 
attendance code for students, either by typing in the code, or by using the drop-down list. Right-
click the cell (Windows) or Ctrl-Click (Macintosh) and select the code from the context menu.

Recording in Many Cells at Once  You can quickly fill the cells with an attendance code.

To record in many cells at once:
1. Right-click the cell (Windows) or Ctrl-Click (Macintosh) and select Fill Chart.

2. Enter the absence code you want to replace all cells with.

3. If you prefer, select Replace only Empty scores to leave existing codes untouched.

4. Click OK.
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Managing Student Pictures
If you have student pictures in digital format, you can see them in the seating chart view and in the 
Students screen available from the Setup menu. Pictures are especially useful for substitute teachers 
taking class attendance. 

For Windows, the pictures must be in .jpg or .bmp format. The Macintosh platform supports those two 
formats, as well as many other formats including .pict, .gif, and any other file that can be read by 
Quicktime 3.0. 

To manage student pictures:
1. From whatever source you have obtained them, move the picture files to the Pictures folder in the 

InteGrade Pro folder on your hard drive.

2. Use a text editor (Notepad in Windows or SimpleText in Macintosh) to create a text file named 
xrefpict.txt and save it in the Pictures folder where the pictures are stored. The system uses this 
file to link each student to their picture.

Each line of the file contains a student number in quote marks, and the filename of their picture 
in quote marks. The information is separated by a comma.

For example, the contents of the xrefpict.txt file might look like this for students 3401, 3402, and 
3403:

"3401","517.BMP"
"3402","667.BMP"
“3403”,”534.BMP”

If every student does not have a picture, no error messages are created. You will not see a picture 
of that student.

NOTE: If you are using the Windows version of the InteGrade Pro software, you must preview the 
seating chart at a magnification of 100% (full size). If you view the chart at any other size, 
the student pictures are displayed as black boxes.
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Exporting Daily Attendance 
If you set up your gradebook by importing data from your administration system, you can export daily 
attendance results. You can do this while in an attendance spreadsheet or while using the seating 
chart. If you did not import data from your administration system, you cannot export data back, and 
this procedure will not work.

Attendance data is exported as an AXxxxxxx.GRD file and is exported to your teacher folder or 
wherever your CL (class roster) files are located. Your administration system can then import this file 
to record daily attendance. This feature is implemented for the TSS, Osiris, CIMS, and SASI III 
software products. The the SASIxp software uses the Classroom module to report attendance. 

To export from an attendance spreadsheet:
1. Click the column containing the data you want to export. You can also right-click any cell in the 

column.

2. From the drop-down list, select Export This Day’s Attendance. A message displays asking if 
you want to proceed with the export.

3. Click Yes. A progress bar displays indicating that the attendance data has been exported.

To export from a seating chart:
1. Either Right-click a student’s desk and select Export This Day’s Attendance from the drop-

down list, or select the Export Attendance button. A message displays asking if you want to 
proceed with the export.

2. Click Yes. A progress bar displays indicating that the attendance data has been exported.
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8 Finishing Up the Reporting Period

Depending on how your school and district are set up, at the end of each reporting period, you may 
need to export or send data to the school administration computer to collate grades and print report 
cards. This chapter shows you how to export data using the End Term spreadsheet.

If your school does not use an administration system or if you did not import your data at the start of 
the reporting period, you cannot export your data from InteGrade Pro gradebook software. In that 
case, you may want to print a Spreadsheet Report as a record.

Preparing the End Term Spreadsheet
The End Term spreadsheet holds the marks and comments exported to the administration system. 
The system automatically creates the End Term spreadsheet when you import data from the 
administration system at the beginning of the reporting period. 

Check with your system administrator to find out what specific format your school uses for this 
spreadsheet.

During the export process to the SASIxp, SASI III, CIMS Student, TSS 8.0, and Osiris v5.0 software 
products, the term indicated by the name of the End Term spreadsheet, displays with the collection 
date. For example, 9/4/1999:1st Progress Report.

Excluding Unnecessary Tasks
Toward the end of a reporting period, your class file could contain tasks you do not want included in 
the calculations until the next term. Do not delete these tasks. Instead, use one of two methods.

To exclude unnecessary tasks:
Do one of the following:

From the Setup menu, select Grading Rules screen. On the Grading Rules screen, define a 
task type called Not Used and set it to contribute 0% towards the final grade.

Change all tasks that you want to exclude from the calculations to this type before using the 
End Term spreadsheet.

OR

Create a new spreadsheet called Unused or Next Term.

Copy all the relevant tasks to this spreadsheet and delete them from the current spreadsheet.
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Hot Linking Numeric and Skill Spreadsheet Grades to End Term Spreadsheets
The InteGrade Pro software now allows you to link the spreadsheet grade from a numeric or skill 
spreadsheet to a column on an End Term spreadsheet. When you use the copy task wizard you have 
the option to automatically link (hot link) the spreadsheet grade to the End Term spreadsheet 
(provided you are copying from a numeric or skill spreadsheet to an End Term spreadsheet). Once you 
establish a hot link, each time the numeric or skill spreadsheet grade is recalculated, the link on the 
End Term spreadsheet is automatically updated. You can remove a hot link at any time or recreate 
one if it is broken inadvertently.

As part of this new feature, the system now includes a spreadsheet setting that controls the display 
color of hot linked text. You access this feature via the Setup | Display | Spreadsheet tab. All hot 
linked amounts are displayed in the color you select.

To create hot links:
1. In the Class Viewer, select the End Term spreadsheet to which you want to copy grade total 

information.

2. From the Tasks menu, select Copy Tasks.

3. On the Copy Tasks screen, select a numeric or a skill spreadsheet from which to copy the 
spreadsheet grade.

4. Click Next.

5. Select the spreadsheet grade total and click Next.

6. Select the End Term spreadsheet column into which you want copy the information and click 
Next.

7. If you are copying from a numeric spreadsheet, you have the option to transform the scores as 
they are copied. Select the type of transformation you want to perform on the score and click 
Next. If you are copying from a skill spreadsheet, you do not have the option to transform the 
scores.

8. To create the link, select the Hot Link Grades check box and click OK. The grades are copied 
and the information displayed in the column on the End Term spreadsheet. The hot linked text is 
displayed in the hot linked text color.

Editing and Removing Hot Links  If you manually edit one of the scores in the linked column on the 
End Term spreadsheet, the hot link for the entire column is removed. The text is no longer displayed 
in the hot linked text color. It reverts to the color of manually entered text.

If you want to recreate the hot link, you can do so using the Creating Hot Links procedure.
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Entering Comments
Comments are the short phrases used on report cards to describe the progress of a student.

To enter comments:
1. Import the COMMENTS.TXT file into the InteGrade Pro gradebook software. Importing stores 

the comments in the gradebook.

NOTE: Check with your System Administrator. This step may have been done at the beginning of 
the year.

2. Open the End Term spreadsheet and select the appropriate cell in the Comment #1 column.

Figure 8-1. Comment columns

3. Enter the comment in one of three ways:

Use the Comment drop-down list above the spreadsheet. This list is available only if you 
imported comments. 

OR

If you know the comment number, enter it directly into the spreadsheet cell.

OR

Right-click the cell (Windows) or Ctrl-click (Macintosh) and select the comment from the 
context menu. The text for the comment displays in the drop-down list for your verification.

4. To enter more comments, use the two adjoining comment columns.
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To enter comments without a Comments.txt file:
1. Ensure that you have a list of comments to use. Each comment must have a number.

2. Enter the comment numbers into the appropriate comment columns.

Entering Attendance Summaries  A report card needs a summary of attendance. Copy the attendance 
into this End Term spreadsheet.

To enter attendance summaries:
1. Click the All Absences or All Tardy column heading.

2. Select Replace Task from the drop-down menu.
Figure 8-2. Replace Task dialog box
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3. Select the class and Attendance spreadsheet from which to copy attendance totals. Click Next.
Figure 8-3. Selecting an item to copy

4. Select the Attendance Summary from the list of items to copy (the first item on the list). Click 
Next. 

Figure 8-4. Selecting codes
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5. Select the attendance codes to total into the summary. Click Next.
Figure 8-5. Selecting date range

6. Select a date range for which to calculate attendance summaries. Click Next.

7. Click OK to continue. The attendance totals copied from the attendance spreadsheet fill the 
column.

You can use the Copy Tasks command from the Tasks Menu to obtain similar results. 
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Entering Final Grades
Use this procedure for copying grade totals manually to an End Term spreadsheet. If you have 
already created hot links to link spreadsheet grades to the End Term spreadsheet, some of the final 
grade work will already be done. Hot links are available for linking the spreadsheet grade from 
numeric and skill spreadsheets only (“Hot Linking Numeric and Skill Spreadsheet Grades to End 
Term Spreadsheets” on page 70)

To enter final grades:
1. Click the title of the appropriate End Term spreadsheet column to display a drop-down menu.

2. Select Replace Task from the drop-down menu.
Figure 8-6. Selecting a class and spreadsheet to copy

3. Select the class and spreadsheet from which to copy scores and click Next.
Figure 8-7. Selecting an item to copy
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4. Specify the information to copy. The choices are:

Summary grade—The students’ overall grades in the spreadsheet.

Type total—The students’ performance over a specific task type. 

Task score—The students’ performance on a specific task. 
Figure 8-8. Choosing a transformation

5. Indicate how the End Term spreadsheet should display the grades. It is important that the scores 
be displayed in a format expected by the administrative system; for example, letter grades or 
percentages.

6. Click OK to continue. The grades copied from the main spreadsheet fill the column. You can edit 
the copied data on a cell-by-cell basis if needed.
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Working With the End Term Spreadsheet

Clearing Columns
Use this procedure when you need to clear an entire column. You cannot erase the student name and 
demographic columns.

To clear columns:
1. Click the heading of the column to erase. 

2. Select Fill Column from the drop-down list.

3. Do not enter a New Score. 

4. Click Fill.

5. Click Yes to confirm that you want to replace the scores with blanks.

Sorting On Columns
Use this procedure to reorder the End Term spreadsheet for your own informational purposes. 
Sorting the spreadsheet does not affect the order in which student records are exported. 

To sort on columns:
1. Click any column heading.

2. Select Sort Students by Column or Sort Students. 

Printing the End Term Spreadsheet
To print the End Term spreadsheet, print the Spreadsheet report while the End Term spreadsheet is 
active in the class viewer. 

You should print the End Term spreadsheet to verify the entries in the End Term spreadsheet before 
submitting data to the office. 

If you are not electronically submitting data at the end of the reporting period, the Spreadsheet report 
contains enough information to create report cards by hand.
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Exporting Data
After creating and verifying the End Term spreadsheet, the next step is to send the information back 
to the administration office. However, you are not really sending the End Term spreadsheet or the 
End Term report. Rather, the End Term spreadsheet contains summarized information in an export 
file and that file is sent to the office.

If you connect to the InteGrade Pro Server software, the End Term spreadsheet information is 
exported to the server from where it can then be imported into the administration system. If you 
export to your local drive on your computer, you must copy the exported file onto a diskette and 
deliver it to your system administrator.

Requirements
To ensure a successful export, check the following for each class exported:

Every student has the correct student number.

Every class has a course and section number. Some classes may require a Subject ID (check 
with your system administrator). Check the Advanced Fields on the General tab, located under 
Classes in the Setup menu, for this information.

You have several blank, formatted disks if exporting using disks.

Exporting Data

To export data:
1. From the File menu, select Export from Gradebook.

2. Follow the on-screen prompts to save to the teacher folder corresponding to your teacher number. 

3. Take the exported file from the specified location and deliver it to the main office. If you are set 
up to connect to the InteGrade Pro Server software, the file is exported to the server.
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Delivering the File
This procedure is applicable only if you are working remotely and you do not connect to the 
InteGrade Pro Server software. If you connect to the InteGrade Pro Server software, you can export 
files and save gradebooks on the school’s server from remote locations eliminating the need to hand 
deliver the data.

After creating the export file, deliver it to the school office. The school produces report cards by 
combining export files from all teachers in a school.

There are several ways to submit the export file. Your system administrator will tell you about the 
procedures at your school. The following are some common methods:

Copy the export file to a specific directory on the network.

Submit the export file on a disk.

Send the export file using e-mail.

After sending the export file to the office, make another copy of the export file on a disk and archive it. 
As an additional safeguard, keep the export file on your hard disk until the report cards have been 
printed. It is not necessary to delete the file when you create an export file at the end of the next 
reporting period. Your hard disk automatically overwrites the export file.

Archiving Your Gradebooks
It is good practice to archive your gradebooks at the end of a reporting period. 

Note that this procedure only works for locally-stored gradebooks. This procedure is not applicable for 
gradebooks stored remotely on the school’s server.

Preparing Gradebooks for Archiving

To prepare gradebooks for archiving:
1. If you have used a gradebook password, remove the password from the gradebook. You may need 

the gradebook for future reference and may not remember the password. Other school personnel 
also may need access to your files. See “Using Gradebook Passwords” on page 59.

2. Lock the scores on the spreadsheets. This prevents the scores from being accidentally modified or 
deleted. See “Locking and Unlocking Scores” on page 63.

3. Optionally, use your operating system to change the file properties to read-only, to prevent 
accidental changes to the file.
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Printing Archive Reports
Along with archiving the class files electronically, it is equally important that you retain archives in 
paper form. This provides an additional safeguard in case the electronic backups fail.

The two reports essential for archiving are the Spreadsheet report and the Student Progress reports. 
Together, they show all information for a class file.

Remember to print these reports for each spreadsheet that you use. See the sections on spreadsheets 
and student progress.

Backing up the Gradebook 
After removing the passwords, save your gradebook file on a blank, formatted disk. Leave the original 
file on the hard disk.

You should also retain the installation disks for the product. Future versions of the software can 
always read the files from the version immediately previous, but there is no guarantee that they can 
read class files that were created several versions back.

In Windows, the gradebook files have a “GBF” file extension. The Macintosh uses a unique icon to 
indicate the gradebook files. By default, the product stores the gradebook files in the same directory 
as the InteGrade Pro files.

For instructions on copying files, see the user manual that came with your computer.

Store all backups, along with a set of the InteGrade Pro installation disks and the archive reports, in 
a safe place for future reference.

NOTE: Users who store their gradebooks remotely on the school server also have a number of 
gradebook backups that are automatically saved by the InteGrade Pro Server software. Your 
system administrator sets the number of files to be saved and can assist you with restoring a 
gradebook file should a problem occur.
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